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INTRODUCTION
» TO COMPUTERS

oy

Computer is a machine that helps us in our daily life. In this unit, students will
learn the definition of a computer, advantages of using a computer, data and
information used in a computer. They will also learn about input, processing,
output, and storage devices and operations.

Learning Outcomes:
After completing this unit, students will be able to:
¢ define Computer © know Communication Devices
define Data and Information © know how a computer works
explain the advantages of & describe four basic operations
using computers performed by a computer

define Hardware and Software
(' know the difference between
Hardware and Software
* know Input Devices
know System Unit
know Storage Devices
know Cutput Devices




1.1 What is a Computer?

When someone says the word “computer”, you may think of a machine that looks
like this...

Syztem Linit

This is a Personal ‘Nﬁ
~| Computer.

Muoupse

Fig. 1.1a Persanal Computer

A computer is an electronic machine which processes raw data (input) into
meaningful information (output), and also stores output for later use. It always
performs according to the given instructions.

Ihere are different categories of computers. Some of them are given below:

5.8

PDA Smart Phone

Palmiap




Introduction to Hardware Basics

1.1.1 Data and Information

A collection of facts and figures (unprocessed items) is known as Data. It can be in
the form of a text, numbers, images, audio and video,

Data after processing is called information. Information is basically a meaningful data
easily understandable by people.
' Processing is an action in
Data - which computer converts.
& | nataintu Information.

&
vﬂ”b Data is processed
: into information
by a computer. In
this example
student's name,
address, subjects
and marks obtained
in each subject
represent data. The
computer processes
this Data and turn it
_into Information
_in the form of the
grade certificate.

» Total Marks Obtained = 417
* Maimum Marks = 500
» Porcentape = §3.4 %

o Grate=4A




1.1.2 Advantages of Using Computers

There are several advantages and benefits of using computers. Some of them are
discussed below:

Speed

Speed is the most important characteristic of a computer. The computer can
perform billions of calculations in a fraction of a second.

For example, if a student is asked to calculate the following product.

9836572
X 68935

The student will take few minutes to solve it, but a computer can solve millions of
such problems in less than a second.

Accuracy

Computer is almost 100% accurate and it never makes mistakes. In the above
example, there is a chance that the student can make errors while solving it
but a computer never does so.

Computer gives wrong results only when defective data or instructions are
given.

Diligence

Besides being fast, a computer can do things over and over again. It never gets
tired or bored. If we have to write a letter 100 times we will get tired. A computer
can write the letter even a million times but never gets tired or bored.

Storage

Computers have large storage capacity. A computer can store very large amount
of data. A large bullding is required to store thousands of books. But a computer
can easlly store thousands of books in its memory.

Versatility

Versatility is the key benefit of using computers. A user can perform variety of
tasks with a computer like drawing pictures, writing stories, watching movies,
playing games, etc,



Unit-1

1.2 Components of a Computer

A computer has different components to perform a variety of tasks. Hardware and
Software are the main components of a computer.

Hardware

Hardware refers to all physical parts of a computer that we can see and touch. This
includes the input and output devices as well as the system unit.

Fig. 1.2a Computer Hardware

Software

A computer cannot perform a task with hardware alone. It needs software too.
Software Is the set of instructions given to the T
computer to perform a specific task.

For example, the games we play and the programs
we run on a computer i.e. Windows XF, Microsoft
Word, Microsoft Paint, etc. are software.

Fig. 1.2b Software
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1.2.2 input Devices

Devices that are used to enter data into a computer are called input devices. The
widely used input devices are the keyboard, mouse, microphone, scanner and digital
camera.

Keyboard

Keyboard is the most commonly used input device. It allows a user to type alphabet,
numbers or symbols inta the computer. It has small buttons called keys. The keys are
laid out in the QWERTY pattern. Now look at the keyboard again @ W E R T Y are
the letters on the top left of the keyboard.



Function Keys
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Alphanumenc Keys Cursor Control Keys
Fig. 1.2.2a Keyboard

A standard keyboard can be divided into following sections.

& Function KE)"S

@ Alphanumeric Keys

@ Numeric Keypad
@ Cursor Control/Navigation Keys

Function Keys

Numeric Keypad

The Function keys are located at the top of the keyboard. The purpose of these
keys is based on the software we are using. For example, pressing the F1 key

opens the Help screen in Windows.

Alphanumeric Keys

Alphanumeric keys are the collection of letters, numbers and punctuation keys. This
section also Includes some special keys, the Tab, Caps Lock, Back Space, Enter; Shift

Ctrl and Alt keys.

Numeric Keypad

The numeric keypad is usually located on the right side of a standard keyboard. This

section contains digit keys and mathematical operator keys (+, -, *, /),

Cursor Control/Navigation Keys

Cursor control keys consist of Arrow keys, Insert, Delete, Home, End, Page Up, and

Page Down keys. These keys are used to move cursor within the text.

7



Keys Functions Keys Functions
.;55-?—‘_?? Tab key lets you move the cursor e ﬁﬂmwﬁmm-ma-m
™ = " | more than one space at a time. S0 el  or number typed incorrectly

= Escape key ts used to terminate _ﬂ_-i Wwf_hmma
sc | - letter or number
] -
any process In between, | e
the C when oy

]—; Py:ﬁwm:omm:xrdh " Home key moves the cursor to the

oy _ i Fome beginning of the line or screen,
e These keys do not work on their .
E.' own. They are used in combination b—+ End key moves the cursor to the

5? with another key For example: | End : end of the ine or scraen,
| Ciri + O = Open a new file g

Alt + F4 = Close any programiwindow

Enter key is used: : SNt keys are used ¢
- I} to start a new line ~ I} to type capital letters,
i e 2) to execute a command 2) to type symbols,

Mouse

The mouse is an input device that enables a user to select commands quickly and
perform tasks. It has two (sometimes three) buttons to click on.

Button

Fig. 1.2.2b Mouse

[ ]
As the mouse moves, the arrow on the screen will move at

the same time. This arrow Is called the mouse pointer.
0

e




Components of a Computer

Mouse Actions
Click: Quickly pressing and releasing the mouse button once is called click.

Clicking on the left mouse button Clicking on the right mouse button will
will highlight the Icon. _display a shortcut or quick menu.

Click

Double Click: Quickly pressing and releasing the left mouse button twice is
called double click. This method is used to open a folder or run a program.

Click

W To press and continue to hold down the left mouse button and move the
mouse |s called dragging.

Drop: After dragging, releasing the left mouse button to move an object is called drop.

9




A Scanner is an input device. It is used to scan text and images into the computer;
Once a document or picture is scanned, it can be displayed on the screen of the

computer,

It works like a photocopy machine,
It creates a copy of document or
image in the computer.

Screen of the
Computer

Seanner

Fig. 1.2.2¢c Scanning Process

Digital Camera

A digital camera s an input device. It allows a user to take pictures and make
videos, then store them in the computer instead of a traditional film. You can see a
picture on the screen of the camera. Digital cameras have built-in memory to store
images. Digital camera provides a feature to delete and edit an image after taking it.

You can view the picture on the
LCD of vour digital camera

Taking Picture

the computer.

Fig. 1.2.2d Digital Camera

1



Components of a Computer

Microphone
A microphone is an input device. It is used to input audio

in the computer. We can record voice using microphone
in the computer, Microphones are used to make audio ;

and video calls-and chat over the internet. \_) P

y 4
12.3 Syste'n un't Fig. 1.2.2¢ Microphone

System unit is a box which consists of drﬁerent electronic components. These
components are main circult board, processor, power supply, storage devices, etc.

I'I
Fig. 1.2.3a System Unit and its Components

System unit can be found In different shapes and sizes .

Svslein Lind

System Lins

Syatern Lnit




T Unit-1 )
Motherboard

Motherboard is the largest circuit board in a computer: It is also known as the
System board. All computer components are plugged or connected with it.

Following are some of the computer components attached to the motherboard.

@ Processor @ Input/Output devices
@ Memory Chips & Storage devices, etc.

Processor

RAM slots

Fig. 1.2.3c Motherboard

Processor

Processor is the brain of a computer. It is made of a silicon chip fixed on the
motherboard. Its primary job is to carry out a set of instructions and process
data efficiently and accurately. It converts data into information. It is also called
CPU (Central Processing Unit).

Fig. 1.2.3d Processor



Components of a Computer

Memory
Memory is an electronic holding place. It holds instructions and data that a computer’s
processor can access. Usually, the term ‘memory’ refers to the RAM (Random Access
Memory). RAM is the temporary storage
area for the data, before and after it is
processed. RAM |s also known as
volatle memory. It means that RAM
loses data when power is switched off
It is a high-speed memory.

How to Find Processor Speed and Memory Size of
the Computer? ; :

= Right click the
My Computer icon
on the Desktop.

Fig 1.2.3¢ RAM

=& Click Properties.

=) System Properties dialogue box
appears.

=p Computer's general information
appears showing Processor speed
and Memory size.

=5 Now write down the Processor speed
and Memory size of your computer.

Processor Speed

Memory Size : =)

Fig 1.2.3f System Properties dialogue box

51‘
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Components of a Cumpter

1.2.4 Storage Devices
In a computer, storage devices hold data, instructions and information permanently.

Storage devices have a much larger capacity to store data. Some common examples of
storage devices are Floppy disk, Hard disk, CDs/DVDs and USB flash memory.

Floppy Disk

Floppy disk is a portable and inexpensive storage device, It consists of a flexible
thin magnetic film. This film is enclosed in a plastic case. A standard floppy disk is
3.5" inches wide.

A floppy disk drive is used to read and
write data from fioppy disk. Nowadays,
it is rare to find floppy disk drives in
modern computers. Floppy disks are
not widely used due to their low

storage capacity.

Hard Disk

Hard disk is the permanent storage device of a computer. It is also calied a Hard
disk drive or Hard drive. It is a reliable and durable storage device. It Is fixed
inside the System Unit.

Hard disk consists of several rotating disks called platters. Each platter stores data.

They are sealed in an airtight case to keep them free from dust. it can store very large
amount of data and information.

Fig. 1.2.4a Floppy Disk

Spindle
- fﬁ?smal!mumr,
which rotates platter.

Platter
.~ i atores data,

Fig. 1.2.4h Hard Disk

; Read/Write Head
— IElosed e reao and write data on

the platter



 Components of a Computer

Nowadays, external hard disks are also available in the market.

Fig. 1.2.4c External Hard Disks

CD / DVD

CD/DVD is a portable and comparatively less reliable storage device than a Hard
disk. They are flat and round discs made of plastic. A CD/DVD has a thin layer of
material that reflects light easily. The CD/DVD drives use a laser beam to read from
and write data on them. :

CD/DVD are used to store software, data, pictures, movies, music and video games.

' 14

¢ DVDstands for Digital Versatile/
Video Disc.

& ADVD can only run in a DVD drive.

@ Quality of sounds and movies
is high in a DVD.

Fig. 1.2.4d CD/DVD

15
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Components of a Computer

USB Flash Memory

USB Flash memory is a storage device. It is also known as Data Traveller. It is plugged
In the USB port of the computer. It is a portable, inexpensive, reliable and durable
storage device. :

Flash memory Is small and light weight. it
consists of a memory chip. We can read
from and write data on the flash memory
It is widely used to transfer data from one
computer to another.

1.2.5 Output Devices

Once the data is processed, it can be displayed in different ways. Devices that show/
generate output are called output devices. Monitors, printers and speakers are
some of the output devices.

Monitor -

Monitor s an output device. It displays information on the screen . It is the main device
. To see results (output). It is also known as VDU (Visual Display Unit). The output which
Yis displayed on the monitor screen is called soft copy There are different types of

monitors. Some of them are shown below.
L |

Fig. 1.2.4¢ USB Flash Memory

| TR

Fig. 1.2.5 Different Types of Monitors

16




Printer

Printer is an output device. It gives output on the paper. The printed output s called
hard copy. The most common types of printers are laser, ink-jet and dot matrix
printers.

Dot Matrix Printer

Dot matrix printer prints
by arranging dots on a
paper. The quality is not
very good but the
printinig cost is less. It
produces 3 noise during
printing.

. " Fig 1255 Priniers
Speaker

Speakers are output devices. They allow us to hear different sounds. Some computers
have small internal speakers.

Fig, 1.2.5c Speakers




~Components of a Computer

1.2.6 Communication Devices

The devices which are used to communicate and connect a computer with other
computers are known as communication devices.

Modem

A modem is a device which is used to connect and communicate with other
computers on the Internet. It sends and receives data. There are two types of
modems. ‘

Internal Modem
Piaced inside the System Unit

Fig. 1.2.6 Modems

18




How a Computer Works?

1.3 How a Computer Works?

The way a computer works is very much similar to the way human beings solve
their problem using paper and pencil. There are four basic operations performed by a
computer i.e. Input, Processing, Output and Storage.

inabag
to use it
Iater.

You Computer
— - =
: “ Computer receives
Ix6=7 . numbers
2 ] ~ from the
=3 Youread a oA
= question,
3Ix6=18 Computer
. works
_E’ = an the
2 You think kU
E | about the
and solve it.
answerona C:’_I'IP’-HEF
a I:", P s
g pape e result
g. ona
monitor.
Computer can
:zll.:rc:l;rsg-'ﬂ use disks, CDs
ur work and DVDs to |
store data.




Input Operation

In this operation, the computer accepts data and instructions from input devices. The
input devices include keyboard, mouse, scanner, digital camera, microphone, etc.

Processing Operation
The operation in which a computer performs some action on the data according to

the Instructions is known as processing operation. The processing is done by the
Central Processing Unit (CPU).

Output Operation
In this operation, the computer uses output devices to produce results of the

processing (information). It may be either displayed on the screen or printed on
the paper. Audio output is produced by speakers of the computer.

Storage Operation
In this operation, the computer stores the data/information on different storage
devices such as Hard disk, Floppy disk, CD/DVD and Flash memory.

s . ™

= 1=

= Qutput Dperatiun J

Input Processing
‘Operation | ' Operation |
SR TR SR RS aE _: >
Fig. .3 Basic Operations of a Computer
\% - J
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Computer is an electronic machine which processes raw data (input) into
meaningful information (output), and also stores output for later use.

Computer can help us in our work. It helps us to write text, solve problems, cnunt,
draw paintings, etc.

Collection of facts and figures is known as Data.

Data after processing is called Information.

Hardware refers to all physical parts of a computer that we can see and touch.
Software Is the set of instructions given to the computer to perform a specific task.
Devices that are used to enter data into a computer are called input devices.

Keyboard is most commonly used input device. It allows a user to type words,
numbers or symbaols into the computer.

Mouse is an input device that enables a user to select commands quickly and
perform tasks. 5
Quickly pressing and releasing the mouse button once is called click.

Quickly pressing and releasing the left mouse button twice is called double dlick.
To press and continue to hold down the left mouse button as you move the mouse
is called dragging the mouse.

Scanner is used to scan text and images into a computer.

Digital Camera allows a user to take pictures and store them in a computer
instead of a traditional ' .

Microphone is an input device. It is used to input audio in a computer.

System unit is a box which contains different electronic components of the
computer e.g. motherboard, processor, power supply, etc.

Motherboard is the largest circuit board in the computer. All computer
components are plugged or connected with it.

Processor is the brain of a computer. Its primary purpose is to carry out a set of
instructions and process data efficiently. It is also known as CPU.

Memory is the electronic holding place. It holds instructions and data that a
computer's processor can access.

Storage devices hold data, instructions and information permanently.
Floppy disk is a portable and inexpensive storage device.

-
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Hard disk is a permanent storage device of a computer. It is an inexpensive,
- reliable and durable storage device. It is fixed inside the system unit.

CD/DVD s a portable, inexpensive and comparatively less reliable storage device
than a hard disk. These are fiat and round discs made of plastic.

A USB Flash memory is a storage device. It is a portable, inexpensive, reliable and
durable storage device.

Once the data is processed, it can be displayed in different ways. Devices that
generate/show output are called output devices.

Monitor is an output device. It displays information on the screen.

Printeris an output device. It gives output on paper. The printed output is called
hard copy. '

Speakers are output devices. They allow us to hear sounds from a computer.

Communication devices are used to communicate and connect a computer with
other computers.

Modem is a device which is used to connect and communicate with other
computers on the internet.

The operation in which a computer accepts data and instructions for processing
from input devices is known as input operation.

The operation in which a computer performs some action on the data according
to the instructions is known as processing operation.

In an output operation, the computer uses output devices to produce the resuits
of the processing ( information ).

In a storage operation, the computer stores data/information on different storage
devices such as Hard disk, Foppy disk, CD/DVD and Flash memory.

Exercise

Q.1 Tick the right cholce.

)

can consist of text, numbers, images, audio and video.

a) Data b) Delta

c) Date d) Deta




Introduction to Computers

ii) Meaningful data Is known as

a) Calculation b) Information
¢) Bvaluation d) Situation ot
i) Hardware are the parts of a computer.
a) Logical b) Physical
c) Conceptual d) Technical

iv) Which of the following is the example of software!

a) Monitor b} Keyboard
©) Micrasoft Windows d) CD/END
v) In the standard keyboard, keys are laid in pattern.
a) QWARTX b) QERWNYT
¢) QWERTY d) QWERYT
vi) Mouse Is an _ device.
a) Output b Input
) Storage d) Communication

vii) Which of the following Is not an input device?

a) System Unit b) Mouse
) Keyboard d) Scanner

viii) Is used to take pictures and store them in the computer.
a) HGLH-E b) Keyboad
) Digital Carmera d) Scanner

b is an Input device used to record voice in a computer.
a) Microphone b) Scanner
¢) Digital Camera d) Monitor

%) Which of the following is not placed in System Unit?

a) Motherboard 1) Hard disk
c) RAM d) Printe

77




xi) CPU stands for

aJ'(-:enual Fopulation Unit b) Central Processing Unilt
©) Cental Publishing Unit d) Control Processing Unit
Xil) Hard disk is a storage device.
a) Temporary _ b) Permanent
c) Primary . d) Portable
xiil) Monitor is an device, -
@) Processing b) Output
c) Storage d) Input
Xiv) A gives output on the paper.
a) Scanner b} Microphone
©) Mouse d) Printer
xv) There are basic operations performed by a computer.
a) Five b) Three
o) Four : d) Two
Q.2 Fiil in the blanks.
i) Computer follows to perform any task.
i . that you put into a computer are known as data.

iii) Computer games are example of the

iv) click of the left mouse button is used to select an item.

v) Microphone is an | device,

vi) Motherboard is also known as

vil) ' disk are rarely found nowadays.

viii) DVD stands for digital disk.

a4




) A computer performs input, processing, -and storage operafions:.

%) In operation, data turns into information.

Q.3 Define the following.

i) Computer - i) Memory

iii) Software iv) Hard disk

v) Motherboard vi) Processing operation

Q.4 Differentiate between the following.

i) Data and Information . i) Single click and Double click

jif) Hardware and Software iv) CD and DVD

v) Input devices and Output devices vi) Input operation and output operation -
Q.5 Give brief answers to the following questions.

) Write five advantages of using computers.

i) What is hardware? Write the names of five hardware devices.
iiiy Write functions of the following keyboard keys.
a) Tab b) Esc c) Enter d) Shift _ €) Caps Lock

iv) What does a processor do?

\) What is memory? Is it a temporary storage device?
vi) Write a short note on Hard disk.

vil) Wrrte‘advantages of USB Flash memory.

viii) Explain different types of Monitors.

ix) What is a modem? Explain. its different types.

x) Explain the output operation of a computer.

75




Q.6 Match column A with column B and write the numbers of matching

pairs in column C,

A g s e e
i) Software a) Keyboard LE
| 1 Input devices b) Speakers
iii) Audio output | © Permanent storage r
iv) Monitor | d) Produce resuilts i
| v)RAM | e) Terminate the program
vi) Modem f) Windows XP
vil) Hard disk g) Physical parts
| Vi) Printer h) Communication device
x) Esc key | 1) Dot matrix
%) Output operation pLcob
k) Memory
| ) Power supply

Q.7 Label the following keyboard,

Ik FINE— 1
= [ (= I~
mm— | | ey

||a-| a2

i |

|. ﬂl
k. ——n

EL

'_Ei"sii; il
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Lab Activity ( Keyboard )

For each item below, fill in the symbol that would be entered.

Lol + i
+ I

wEEE -
B+E

Lab Activity ( Drag and Drop )

Practice this method by arranging the icons on the desktop to form the first
letter of your name. !

Lab Activity ( Motherboard )

Write the names of computer components which are attached with your
computer.

1) — vy IO

3) 4}

27




Introduction to Computers
- Lab Activity ( Scanning )

Scan the following objects and set it as a wallpaper on your computer. Get the
help of your teacher for this activity.

Lo

Signstares of :
Quaid-e-Azam Mubammad Ali Jinnah

Lab Activity ( Storage Devices )

Discuss with your teacher about the following qualities of Storage Devices.
Choose one of the following options.

Yes

Mot much

Activity ( Monitor )

What type of display device do you have in the computer lab of your school and at
your home? :

Lab

28



INTRODUCTION_ =
* TO WINDOWS

Microsoft Windows is a program that controls the overall activity of a computer.
It provides ways to organize and manage files stored into a computer. A user
can use Windows to sort, copy, move, delete and view the files. It controls the
basic operations of a computer Windows controls different parts of your
computer system such as printer and monitor; and also enables them to work

together.
Learning Outcomes: _
After completing this unlt, students will be able to:
& know the start uppmmdureta step . getfamiliar with mﬂfﬂ'ne
into Windows fullnmﬂnganawﬁﬁaﬂ
o know the fnllwlngpmmfﬁre Windows ~ Title bar, Menu bar, Scroll bar
» Desktop, Start button and Start menu : Smmsbarandw ’
. Taskbar and Notification area *  Maximize and Minimize buttons
+ Desktop icons - ' o Close button
% open a window from the faﬂémm + define a File, Folder and Drive
locations & copy a File/Folder to the Desktop
a Desktop 3 move a File/Folder to the Desktop
o Start menu i (« arag a File/Folder to the Desktop

. & Runcommand - delete a File/Folder




TE I 5 I;I_'_IH- 2
2.1 Steppmg mto Wmdows

Microsoft Windows is the software which provides a platform to work on a
computer We can only work on a computer if there is a software like Windows.

Following are the steps of the start up procedure of Windows,

wi Start your computer by pressing “power” button on the System box.

Fig. 2 la Swifch on a Computer

P Windows XP starts loading its files into the computer.

Windows

Fig. 2.1b Windows loading its files

30



Se;;ﬁihg into Windows
b After successfully loading, Windows logs on and a welcome screen appears.

=& You can log on to computer by clicking user name and typing password
(if assigned) in the text box, as in Fig. 2.1c.

wi Windows Desktop screen appears.

Fig. 2.1d Windows Desktop

3l
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2.1.1 Desktop
The main screen of the Microsoft Windows is known as desktop. The desktop
contains icons of different files and programs, so a user can easily access them, All
programs, windows and dialog boxes open on the desktop. it is the working area
of Microsoft Windows.

Desktop lcons 8

— — i

- S — = Taskbar o e
Quick Launch Taolbar Notification Area

Fig 2.1.1a Windows Desktop

2.1.2 Start Button and Start Menu

At the bottom left corner of the screen there is a Start button. This button displays a
list of items called Start Menu. Different versions of Windows have different Start
buttons i.e.

Start Button . Start Button
Windows 98 ‘Windawa Xp - i o * T and Vista

When a user dlicks the Start button, a menu appears that fets the user easlly access
most useful items on the computer Start menu gives a complete control of the
computer under one menu.

fad
e
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2.1.2 Start Menu A user can log off by

clicking this button.

Users can access all programs installed in the computer by clicking “All Programs” on
Start menu. '

2.1.3 Taskbar

Taskbar is placed at the bottom of the screen (Fig 2.1.1a) in the Microsoft Windows.
It includes Start button, Quick Launch toolbar, Taskbar buttons and Notification
area. Users can access Start menu and different programs from Start button and
quick launch toolbar Users can also switch between programs and windows by
clicking their buttons on the taskbar

; Taskbar buttons of currently
Start button  Quick Launch toolbar running programs Motification area

y - f | _,

[ m———

Fig. 2.1.3 Taskbar

 2.1.4 Notification Area _
The area at the bottom right on the screen is known as Notification area. It is a part of
the taskbar: It shows different notifications of the events that occurs in Windows.
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It also displays Time and different program icons such as Velume Control, Windows
Firewall,and Anti-Virus, etc. It also shows temporary icons such as USB device and
Printing, etc.

Noliﬁ::‘ation Area

2.1.5 Desktoe Icons

lcons are small images that represent different types of programs and files. Desktop
contains different types of icons. Following are the main four icons of the desktop.

w HE e

My Documents

My Documents icon represents My Documents folder. It is used to save documents
such as letters, reports, pictures and media files. By default there are three folders in
the My Documents folder, My Music, My Pictures and My Videos.

Double dlick the icon of My Documents
from the desktop.

s My Documents window appears.




Sfepping into Windows

My Computer

My Computer icon helps a user to access all disk drives and other hardware
connected to the computer. It shows icons of different users, documents, disk
drives such as Hard disk, CD/DVD, Floppy and USB Flash memory.

=% Double click the icon of My Computer
from the desktop.

=% My Computer window appears.

Recycie Bin | :
Recycle Bin is the place where Windows stores deleted files. User can restore any
deleted file from Recycle Bin if it has been deleted by mistake. On the other hand, a

user can empty the Recycle Bin to create more disk space.

=¥ Double click the icon of Recycle Bin
from the desktop.
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Internet Explorer

A user can access Internet Explorer by clicking its icon on the desktop. Internet
Explorer can be used to search and view information on the World Wide Web.

“ Double click the icon of Internet Explorer
from the desktop.

" Internet Explorer window appears.
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Unit - 2
2.2 Working with Windows

Microsoft Windows provides a platform to work on a computer. A user can
easily access programs and windows using different ways in Windows.

There are three different ways to open a program/window.

® From Desktop
® From Start Menu
® From Run Command

Opening Paint Program from Desktop

=% Double Click on
“the icon of Paint.—,

Fig. 2.2a Desktop

w& MS Paint window appears.

Fim, 3.2 MS Paint




=¥ ==
Wi ]f._f::_af; with Windows

Opening Paint from Start Menu
=¥ Click Start button | |4
=& Start menu appears.

=% FPoint to All Programs = Accessories.
=% Click Paint.

«%» Start menu appears. e | dlyve———

w Click Run. I-" T P

R



Wark};g with Windows

=% Run dialog box appears.
= Type the program name |
and path here. T e
Lmhﬁ_m_ ]
= Click OK. o) Come ) (ommn,
=% MS Paint window appears. BeLEm Sl

2.2.1 Get Familiar with a Window

A rectangular area on the computer screen in which an application or document is
viewed and accessed is known as a window. A window allows a user to work easily
with multiple programs. User can minimize, maximize, hide, resize and view a window.

A window and its different parts are shown below.

Wi XHTHEE DL LO]

Nitle b

Liose button

ertical
roll bar

mammmm-*
LA




Wﬁ;_g w Windows
Title Bar

The hoffzontal bar at the top of a window is known as Title bar: It contains the name
of the window/application and its icon at left corner and control buttons (maximize,
minimize and close) at the right corner.

Menu Bar

The Menu bar is located under the Title bar on a window. A Menu bar of a window
contains different menus such as File, Edit, View, Favorites, Tools and Help. These
menus contain all the commands regarding the application/window.

Toolbar

A Toolbar is situated under the Menu bar of a window. It contains different command
buttons with their icons so a user can easily access these commands.

Status Bar

Status bar gives information about the window and its contents, It is usually located
at the bottom of a window. Not all windows have a status bar.

Scroll Bar

Scroll bar is used to view all the contents of a window vertically and horizontally. it
appears when the contents of a window do not fit in its size.

Vertical scroll bar appears on the right side of the window. Horizontal scroll bar
appears at the bottom of the window.

Control Buttons

The buttons on the top right corner of a window are known as control buttons.
They consists of Minimize, Maximize and Close buttons.

Minimize Button ——— Close Button
Minimize button is used to Close button is used to close an
reduce 2 window to a open window or application.

button on the taskbar. A
user can re-display the
window at any time by
clicking the button on the
taskbar.

Maximize/Restore Button
Maximize button is used to enlarge a window
to full screen. It is also known as Restore
button because it restores a maximized
window to its previous size.
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2.3 Managing Files and Folders

One of the main features of Microsoft Windows Is to manage files and folders.
Computer stores data in the form of files. Files are organized in the folders.
These files and folders are stored In the drives such as Hard disks, CD/DVD

and Flash memory. A user can easily store and retrieve data with the use of files
and folders. 4

File

A file is a collection of data that is stored in a computer. There are different

types of files such as text files, graphic files, sound files and program files, etc.
Files can be stored in various storage devices such as Hard disk, Flash
memory drive, CD and DVD drives.

A file tonsists of two parts : name and type. Suppose you want to save the
picture of your friend and give It a name * picture ". Computer will save it as
picture.jpg. :

picturejpg

l ]
File File
name  extension

Folder

Folders are like envelops or drawers in which a user can place data. A folder
can contain files and even other folders. They are used to organize data.

Folder Ilcon
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importance of Folders

Suppose, Ali is looking for his Math book from a big pile of books. He will have to
sift through the pile of books to find Math book. The same thing can happen if

someone does not use folders to store data.

Ali can arrange books in the bookshelves.

— .
Shelf | : Islamiyat books Il i ll
' il l!L El

Shelf 2 : Urdu books
Shelf 3 : English books 100 = B
Shelf 4 : Math books il ;E

Shelf5: Sciencebooks —— I| ﬂl_ l

When Ali wants to look for a particular book, it is now much easier to find because
they have been organized into several categories. Similarly, data in a computer
can be organized in the same way with the help of folders.

Several folders can be created in the computer: For example:

—— —_— L

Math English Computer Science
Math folder English folder Computer folder Sclence folder
contains files related contains files refated contains files related contains files related

to Mathematics. to English. to Computer o Science.

AR
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Drive
A storage area in any storage device is known as drive. Drives are named by a
letter followed by a colon (such as C). The storage device can be a Floppy disk, a

CD/DVD, a Hard disk and a USB Flash memory.

=» Open My Computer.

- n

r

@

W Comois

BICSERLGREE | L

Iy Ll i

S )

S LI

|

‘Cb‘aﬁv_e Fig. 2.3 My cm:m

Hard disk drives

s In this window user can access and get information about all disc drives and other
hardware connected to the computer

2.3.1 Creating a Folder

When a user wants to sort and manage files and data, he/she creates a new foider.
There are different methods of creating a new folder in Microsoft Windows.

Creating a Folder using Right Click Menu
wd Right click anywhere on the desktop. -
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wi Right click menu
appears.

= Move mouse over NEW.

=® Click the Folder option.

- The new folder appears, i e ———
displaying a temporary o
name (New FﬂldEﬂ MNew Folder e ,:. ; i ;

w) Type a name for the new folder . - .
(for example, My Work) ] . SCOTA
and Pmssg : S il R - R

\ . pun i
wd A folder with the name My Work has been created on the Desktop.

Create a Folder from File Menu

wh Open My Documents folder.

s Click File menu.

=) Move mouse over
NEW.

= Click the Folder option.

Fig. 2.3.1b My Documents window



=) Type a name for the
new folder (for

example, My Work)

and Pressn-F-j

= A folder with the name My Work has been created in My Document folder.

Creating a Folder from File and Folder Tasks Pane
wh Open My Documents folder.
= Click on Make a new folder in the File and Folder Tasks pane.

F 2.3.1d My Documents
= The new folder appears, displaying a temporary name (New Folder).
w Type a name for the new folder (for example, My Work) and press E
wi A folder with the name My Work has been created in My Documents folder.
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2.3.2 Creating a Blank File

A blank new File can also be created by using the File Menu.
Creating a blank file from File Menu
wh Open My Work folder in the My Documents (Which you have just created).

s Click File menu.

=& Move mouse cver NEWJ.;

wb Click the
Text Document option.,

Fig. 2.3.2a Creating new text file
wh A new text file appears, displaying a temporary name (New Text Document)
in the My Work folder

=5 Type a name for the
new file (.e. My First File)

and press 5

2.3.2b My Work Folder
«& A blank new text file with the name My First File has been created in the
My W= * folder.
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Creating a blank file from Right Click Menu
A blank new File can also be created by using the Right Click Menu.

=% Open My Work folder in the My Documents (Which you have just created).

= Right click in
the folder.

=% Right click menu
appears.

=% Move mouse
over NEW.

wi Click the

Text Document
option. Fig. 2.3.2c Right click menu

=% A new text file appears, displaying a temporary name (New Text Document)
in the My Work folder.

= Type a name for the
new file (Le. My First File)

and press B

Fig. 2.3.2d My Work Folder

=5 A blank new text file with the name My First File has been created in the
My Work folder.
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2.3.3 Copying a File/Folder

Copying a file/folder is reproducing it at another location (destination) without
removihg it from its original location. Copy feature is used when a user wants to
make an exact copy of a file/folder.

Copying a file/folder to the Desktop
=% Open My Work folder in the My Documents (Which you have just created)..,

nhﬁ_--

ﬂ"‘ Q iF P L_'ﬂ*

=% Select the file
(My First File).

=% Click Copy this file
in the File and Folder
Tasks Pane.

Fig. 2.3.3a Hy m Folder

=% Copy Items window appears,

[‘—"’”

Select the destination (Desktop)
to paste the file.

=& Click Copy.

= A copy of the selected file
will appear on the Desktop.

Fig. 2.3.3b Desktop
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2.3.4 Moving a File/Folder

Moving, cuts the file/folder from its original location and places it at a new location. Cut
feature is used when a user wants to shift a file/folder from one location to another.

Moving a file/folder to the Desktop
=% Open My Work folder in the My Documents (Which you have just created).

=% Select the file
(My First File).

= Click Move this file
in the File and Folder
Tasks Pane.

Fig, 2.3.4a My Wark Folder
= Move Iteins window appears.

= Select the destination (Desktop) 4I : .............ml

to paste the file.

= Click Move.—

= Selected file will be moved
on the desktop. e

Fig. 2.3.4b Desktop
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2.3.5 Dragging a File /Folder

A user can also move a file/folder to another location by dragging.

Dragging a file/folder to the Desktop

=& Open My Documents folder.

= Select My Work folder (Which you have just created).

| M bR Wew Fesle  Tes e

(O O 8 peepmmim

=% Now drag this__
folder on the
desktop.

wh Selected folder will
be moved to the
desktop.

=) You can also drag
this selected folder__
back to My
Documents folder.

Fig. 2.3.5b My Documents and Deskiop
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2.3.6 Deleting a File/Folder

~ Auser can delete a file/folder that is no longer required.

Deleting a file/folder

w=d Open My Documents folder

wh Select My Work __!
folder. :

»% Click Delete this folder
in the File and Folder
Tasks Pane or press
Delete key on the

keyboard.

i A warning message will appear.

=P Click Yes to confirm the delete action. -

= You will find that the
folder (My Work) has
been deleted.

P
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lntruduc;ian to Windows .

Summary

© Microsoft Windows is a software which provides a platform to work on a
computer.

© The main screen of the Microsoft Windows is known as Desktop.
o The Start button displays a list of items called Start menu.

@ Taskbar is placed at the bottom of the screen in the Windows. It includes Start
button, Quick Launch toolbar, Taskbar buttons and Notification area.

© The area at the bottom right on the screen is known as Notification area.
® Icons are small images that represent different types of programs and files.

© My Computer gives access to all disk drives and other hardware connected to the
computer.

© My Documents folder is used to save documents such as letters, reports, pictures
and media files,

®_Recycle Bin Is the place where Windows stores deleted files.

® A rectangular area on the computer screen in which an application or document
Is viewed and accessed is known as a window.

® The horizontal bar at the top of a window is known as Title bar.
© Maximize button is used to enlarge a window to full screen and restore it.

© Minimize button is used to reduce a window to a button on the taskbar
® Close button is used to close an open window.

® A Menu bar of a window contains different menus such as File, Edit, View, Favorites,
Tools and Help.

® A Toolbar contains different command buttons so a user can access them easily.
@ Status bar gives information about the window and its contents,

@ Scroll bar is used to view all the contents of a window vertically and horizontally.
® A File Is a collection of data that is stored on a computer

® Folders are like envelops or drawers in which we can place data.
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Introduction to Windows

Exercise
Q.| Tick the right choice.
)] s a software that provides a platform to work on a computer
a) Microsoft Windows b) Mouse
¢) Hardware d) Scanner

il) The main screen af the Microsoft Windows js known as

a) Front top : b) Welcome screen
©) Desktop d) Home
i) gives complete control of the computer under one menu.
) Windows menu b) Start help
¢) Start menu d) Desktop
iv) Taskbar is placed at the . of the screen in Windows.
a) Left b) Right
<) Top d) Bottom
V) is a place where Windows stores deleted files.
a) My Documents b) My Computer
©) Recycle Bin d) Desktop
vi) Time is displayed in the
) Quick Access Launcher b) Start menu
¢) Notification area d) Task buttons
vii) icon gives access to Hard disk and other hardware.
a) My Document b) Recycle Bin
¢) Internet Explorer d) My Computer
viil) A allows a user to work with multiple programs.
a) Start menu! b) Window

¢) Dialogue bex d) Door
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ix) The window/program name is shown on the bar.

a) Menu b) Tool
o) Title d) Status
x) bar gives information about the window and its contents.
a) Status b) Scroll
o) Task d) Title
xi) is a collection of data that is stored on a computer.
a) Record b) Data store
c) File d) Information
xii) Folders are like in which you can place files/folders.
a) Envelops b) Notchooks
o) Rles d) Registers
Xiii) feature is used to make an exact copy of a file/folder
a) Copy b) Cut
© Drag d) Delete
xiv) Cut feature is used ta a file/folder from one location to another.
a) Copy b) Shift
c) Delete d) Arrange
XV)A is named by a letter followed by a colon ().
a) FAle b) Folder
©) Drive d) Window
Q.2 Fill in the Blanks.
) Desktop contains of different file/folders and program.
it) s used to search information on the World Wide Web.
il bar contains different menus.
iv) A user can any deleted file from Recycle Bin,
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vl baris used to view all the contents of a window horizontally and vertically

vil button is used to enlarge a window to full screen.

vii) Minimize button is used to reduce a window to a button on the
viii) There are ways to open a program/window.

ix) A file consists of two parts : name and
X)) are used to organize data.

Q.3 Differentiate between the following.
) Desktop and Start menu,

i) My Documents icon and My Computer icon.
iif) Maximize button and Minimize button.

iv) File and Foider.

v) Copy a file/folder and Cut a file/folder

Q.4 Define the following.
) Desktop i) Folder Iii) Start menu

iv) A window v) Task bar
Q.5 Give brief answers to the following questions.
) Describe the steps of the Start up procedure of the Windows.
i) What is Start menu?
iii) Describe the function of the Notification area.
iv) How many ways are there to open a window/program in Windows?
v) What is a Drive?
- vi) What Is a file? Write the parts of a file with an example.
vil) How can a user create a folder using right click menu?
vill) What is the importance of fnldér_s?E)q:Jam briefly with an example.
ix) Write'the names of five different parts of a window.
X) What are icons? Write names of the desktop icons,
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Q.6 Match column A with column B and write the numbers of matching

airs In column C.

B e BRRR RS s ) ol b o
1) Desktop a) My Computer
ii) Close button b) World Wide Web
iii) Start menu ¢) .doc
iv) Drive d) Name of the window
v) File Extension e) Close a window/program
vi) Desktop Icon f) Turn off button
vii) Notification Area g Volume Control
viii) Title bar h) Quick Access Launcher
ix) Internet Explorer DC:
x) Taskbar J) Main Screen
k) Different menus
1) Shift a file/folder

Q.-?kLubei the following diagrams.

a)
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Lab Activity (Changing Desktop Background )

You can set any picture as a desktop background.

=& Right click anywhere
on the Desktop.

wy Click Properties. |
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=& Display Properties
dialogue box appears.

=% Click Desktop tab.

»% Select any image from
Background list.

Blue Laca 16
od torri

(&

=% Click Apply.

- —

| Customiss Deshiop. |

=& Click OKto close the g

=

digloguebox. 1

=% The background of your desktop is changed.
Lab Activity (Start Menu)

Write the names of frequently used programs from the Start menu of your computer.

Lab Activity (Notification Area)

Wirite the names of items displayed on the Notification area of your computer.

Lab Activity (Drives)

How many drives are there in your computer?
Write the names of drives in your computer.
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COMMONLY

USED SOFTWARE _

Software refers to the instructions given to a computer to perform a specific
task. The games we play and the programs that we use on the computer are
software. There are different types of software. We will discuss four of them in
this unit, i.e. MS Paint, MS Word, Typing Tutor and Media Player:

Learning Objectives:

After completing this unit, students will be able to:

recognize Microsoft Paint window
get familiar with Menu bar, Toolbox
and Color box

~ draw with Pencil tool

use Shape, Spray, Brush and

other tools

- copylpaste and modify an image
save afile

recognize keys of right and left hands
on the keyboard

use the correct fingers for typing
build basic typing skills

improve speed and accuracy

recognize Word 2007

identify MS Word User Interface
create a new document

edit, select and delete text

copy, cut and paste text

know Fonts, Font size

know Font styles

align and change case of text
check spelling and grammar

save and print a document

use Media Player

know how to use different controls
play a recorded clip '




3.1 Working With Microsoft Paint

M5 Paint is a graphics software. It is one of the commonly used software for
beginners. It Is used to draw and edit pictures and graphics on a computer. A user
can also use Paint to view and edit scanned photos.

Opening MS Paint
Click the Start button.
Move the mouse over All Programs.

Move the mouse aver Accessories,

2R 2R/

Click the Paint. AEOoE s -8

| | Fig. 3.1a Opening Paint
i s semininl}
All Programs Start Button



Working With Microsoft Paint

Canvas or Drawing Area

Fig. 3.1b Paint Window

Status Bar Horizontal Scroll Bar

3.1.1 Menu Bar

Menu bar is located under the title bar, It contains different menus. There are
six menus for different purposes such as File, Edit, View, Image, Colors and
Help.

3.1.2 Toolbox

Toolbox contains tools to create, fill and edit objects. Paint has plenty of tools for
drawing and painting a picture.

The lower part of the toolbox changes to give more options about the selected
tool. '

&l




Warkmg With M::rnsoﬂ Paint

Free-Form Select Tool is used to ——+ {‘1 =
select a freeform area. |

Eraser Tool erases part or all of - a “_
the picture, |

Pick Tool Is used to choosea ——= ! Q-—

color from the working area.
Pencil Tool Is used to draw thin
wavy lines,

Alrbrush Tool creates a spray ———-lL
pattern.

Line Tool is used to draw straight
lines of different thicknesses.

Rectangle Tool is used to make
rectangles.”

Ellipse Tool Is used to make
elllpses.

«+—— Seglect Tool is used to selecta

rectangular area.

Fill with Color Tool is used to fill
an enclosed shape with a color

Magnifier Tool is used to zoom In
and get a detailed view of the work

Brush Tool Is used to draw lines
of different thickness.

—— Text Tool creates a text frame in
which you can type text.

— Curve Tool is used 1o draw curved
lines of different thickness,

—— Polygon Tool is used to draw
different types of polygon.

—— Rounded Rectangle Tool Is used

to draw rectangies with rounded
COrmers.

Fig. 3.1.2 Toolbox

3.1.3 Color Palette

The Color Palette consists of two rows of colored boxes. The default
foreground and background colors appear in the left of the color box. The top

color square represents the foreground co
represents the background cn[ur

The foreground color Is_
used for lines, borders of
shapes and text. You can
change this color at
anytime by clicking a color

in the color box.

s

lor. The bottom color square

71 I_HIF.IIII-IIIII

The background
enclosed shapes and the background of text frames.
You can change this color at anytime by right-clicking
a color in the color box.

color is used to fill the inside of



3.1.4 Draw Lines

Paint lets you draw the following types of lines.

Pencil Tool

Pencil Tool is used to draw freehand. However, /\/\_)

we cannot adjust the thickness of the line.

of brush strokes. /-\N

Line Tool
Line Tool is used to draw straight lines
of different colors and thickness. : ;

Curve Tool

Curve Tool is used to draw curved lines ﬁ

of different colors and thickness.

Drawing Straight Lines

4

\ & £

Select the Line tool H from the Toolbox.
Below the Toolbox, click a line width.

Press and drag the mouse button to draw a line.

Move the mouse pointer in the drawing area.

Line Thickness

Starting point

Choose a new color ' j BE
L *'
from the color box. TN S ﬂ

Below the Toolbox, click a line width.
Draw another line.
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Fig. 3.1.4a Line Tool

You can draw a perfectly horizontal, vertical and 45-degree diagonal line by hnidlgg
the Shift key while dragging.

Drawing Curved Lines
= n the Toolbox, click Curve Tnni'..

=) Below the Toolbox, click a line width/thickness.

= Draw a straight line by dragging the pointer,

=) To curve the line, press and then drag the

pointer until it curves the way you want. \k;l:__yff/

+

=) Repeat this step for the second arc. N SISy S

You can only create two curves for each Iin;e.
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e
Using Pencil Tool { My Self )
=% In the Toolbox, click Pencil Tool .-

mf Try to draw yourself using the Pencil Tool.
=% Write your name too.

Fig. 3.1.4¢ Pencil Tool




Using Fill with Color Tool

= In the Toolbox, click Pencil Tool
= Draw a long twisted line in the drawing area.
=% Fill in the shapes with different colors using Fill With Color Tool .

Fig. 3.1:4d Fill With Color Tool

Using Brush Tool
With Pencil Tool the line thickness always stays sharp and narrow. But with Brush Tool
a user can change the thickness and shape of the line.

=% Use different brush shapes and colors to draw lines like these.

-
1
L |

e -1

>3

Tlllem~

Fig. 3.1.4e Brush Tool




Working With Microsoft Paint

- mp In the Toolbox, click Airbrush Tool.
=P Use different spray sizes and spray as follows.

| 3.1.5 Shape Tools s ¢

We can draw shapes like circles, rectangles, triangles, squares, etc. using Shape Tools.

Rectangle Tool

Rectangle Tool is used to draw rectangles. To
draw a square, hold the Shift key while dragging.

Rounded Rectangle Tool
Founde Rectonle Tol s sd o v recanges () D
with rounded comers. :

Eliipse Tool :
Ellipse Tool lets you make ellipses, To draw a O O
perfect circle, hold the Shift key while dragging.

Polygon Tool
Polygon Tool Is used to draw different types of A m
polygon.




Working With Microsoft Paint
Drawing Rectangles
Select the Rectangle Tool ! 2 Starting point
Move the mouse pointer in the drawing area.

Press and drag the mouse diagonally to draw

a rectangle. Then release the mouse button.
Make rectangles all over the screen and color them. Rsisasing point

LR 2 2

s -?j:-h.' St

ol

Fig. 3.1.5a Rectangle Tool
Paint offers three options to create a shape.

Draws the outline of a shape.
Draws the outline of a shape and fills the inside with color.

Draws a colored shape with no outline.

Drawing Ovals G
m Select the Ellipse Tool .
= Move the mouse pointer in the drawing area.

m Press and drag the mouse diagonally to draw

an oval. Then release the mouse button. a0 poit
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Working With Microsoft Paint

s e
Fig. 3.1.5b Ellipse Tool
Using Text Tool

In the Toolbox, click the Text Tool ' ;

To create a text frame, drag the pointer diagonally to the size you want.
On the Text toolbar, click the font, size and style you want for the text.

Click inside the text frame to type text.

‘44l

Class: 6
‘Section: C

=

Fig. 3.1.5c Text Tool
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Wnrkmg With Microsoft Paint

You can enter text in a text box only once. After you click outside the box,
you cannot make it active again.

3.1.6 Copy/Paste and Modify an Image

=) Using Ellipse Tool, draw a balloon and color it pink.
=P Draw an oval inside the circle and color it light pink.

e ':.zr':.- o g

FaS ik - nE——
B

W —

: ﬁ;g.nsanmdng.nm
wd Click the Selection Tool -and drag the mouse to select the balloon
wd On the Edit menu, click Copy. i
s On the Edit menu, click Paste.

Fig. 3.1.6b Copy and Paste the Balloon

mn



= Change the color of the balloon and

drag it to a new location.

= On the Image menu, click Stretch/Skew.
= Stretch and Skew dialogue box appears.

Fig. 3.1.6¢ Stretch and Skew Dialogue Box
s Under Stretch, type the percent to stretch the image horizontally or vertically

= Click OK. :
w$ The balloon is stretched horizontally

Fig. 3.1.6d Strecch/Skew the Balloon
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=% Similarty complete the drawing as given below.
= Also draw a thread using Curve Tool.

i AU P FUPACE S i .

Fig. 3.1.6e Drawing Threads Using Curve Tool

=& Using Text Tool, type “ Happy Birthday ",

Fig. 3.1.6f Typing Text

=% Now, using Eraser Tool, delete overlapped thr‘eads]

~.]
(]



Fig. 3.1.6g Erasing Unwanted Details
3.1.7 Save File
Now, we are going to save this drawing(file) with the name “Birthday Card”.
=% Click the File menu.

=% Click the Save option or type Ctrl + .

= The Save As dialogue box appears,

=i Select the folder.

=% Type the file name
for the drawing.

T S e i e

s N L ST AT R TR

3.1 ?Smasdmlagux&ax

wh Click the Save button.
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Using a Typing Tutor

3.2 Using a Typing Tutor
Typing is an important skill. It is useful at work and in school. The important
thipgs to remember while typing are:

@ Use the correct fingers.

@ Thereis no need to rush.

@ We should take a rest, shake hands and arms to relax muscles.

@ Itis important not to look at our hands when we are learning to type.

Typing tutor is a software which helps a user to learn and Iﬁ]prmfe typing skills. A user
can install any typing tutor software. After practicing, a user will be able to type fast and
accurate.

3.2.1 Home Keys

ASDFandJKL; are called home keys.

il T F
fﬂl;ral mtﬂﬂliﬂtﬂii}j
<]

Fig. 3.2.1 Home Keys

Place fingers of let hand on ASDF  Place fingers of right hand on J K L ;

Use either of the thumbs to press space bar In order to Insert space between
letters.
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3.2.2 Correct Fingers for Typing
English Text

The color scheme suggests the fingers for the whole keyboard to type English text.

B L [ e
FWIIIIIIIIIIED
Eﬂlzﬂi = HE]

Fig. 3.2.2 Tuble of Keys for Each Finger

Table for ‘l,'yplng Keys and Flngers
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-~ Using a 'l}rprg Tutor

3.2.3 Basic Typing Skiils

A user should always start from home keys and always return to them. In this way,

fingers never lose their place. In first few lessons, typing tutor will help the user to
practice home row.

ASDFGHJKL;
During the lesson typing tutor will show the speed, errors and timing of the typing.

After practicing home row, the user can take lessons for the QWERTY row and the
row (Z X CV B......) under the home row.

QWERTY Row (Row above the home row)
Color scheme suggests which finger presses which key in QWERTY row.

ﬁﬁ@ﬁﬁlﬂﬁﬁlﬂ-
I | 5 i

ATR a2 DAER

Fig. 3.2 3a QWERTY Row
Row below the home row

Color scheme suggests that which finger presses which key in the row below the
home row.

Fig. 3.2.3b Row Below the Home Row
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Number Row

Color scheme suggests which finger presses which key in the number row.

EHBEIEHE.E
=Tl |IEB

Fig. 3.2.3c Number Row

How to run a Typing Tutor 7

= Click the Start button.

=% Move the mouse over All Programs.
=% Move on the typing tutor

= Click the typing tutor (Typing Master).

All Programs |

Start Button
Fig. 3.2 .3d Srart Menu
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=% The typing tutor opens. (The screen of the typing tutor installed on your
computer may be different from this one).

Complete
Training

Fig. 3.2 3¢ Welcome Screen of the Typing Tutor
= After giving user information, the first lesson appears.

Studying

Fig. 3.2.3f Typing Tutor |

=% Click Begin.
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Fig. 3.2.3g Typing Turor

You can also take the remaining lessons of your typing tutor. It will help you to type
quickly and accurately without looking at the keys.

3.2.4 Improve Speed and Accuracy
Through Typing Tests

After learning and practicing all the keys, a user can take typing tests. These tests help
a user to measure his/her typing speed and accuracy,
Speed in typing is defined as the number of words typed in one minute, counting
every five strokes (punctuation marks, spaces, letters or numbers) as one word. For
example, if a user types 30 words in 3 minutes, his/her typing speed Is 10 wpm
~ (words per minute), :

Taking a Typing Test
= Open typing tutor,
=% Choose a test and time duration.

N




Test appears, start typing.

After completing test, result screen appears.

Typing Test

Quaid-e-Azam

Qumid-e-Azam was bom in Karachi on the 25th of December.
1876, in & npnhﬂimﬂx.mm::.pul‘m:n
passing the Matriculstion examination, he was sent i England
hmum.mmmummunmm
mmmammhm&dnwm
soon became ong of the leading lawyers.

Fig 3.2.4b Typing Test

Yo vy peised this hyping test. Prass the bumon
Bt o primt o diploma.

Fig 3.2.4c Typing Results

&n
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Unit - 3

Word processing means to create, edit and print text documents using software
on a computer. The software used to produce text documents on a computer is
called a word processor. Word 2007 is one of the most popular word processing
software. It is used to produce reports, messages, notes, letters and other
documents.

There are some special words you need to know in order to do word processing.
Words are called text.
The whole text is called a document.

Click the Start button.

Point to All Programs to view a list of programs in the computer.
Point to Microsoft Office.
Click Microsoft Office Word.

i mg

Fig. 3.3a Opening Word
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Mimimize Close (it}
= -

Status Bar

Fig. 3.3b Word 2007 Interface

Office Button ® . -
Office Button is at the top—'Ieﬂ: corner of the Word window. It provides fast
access to files and frequently used commands such as create a new

document, Open an existing dccument: Save a document, Print a document

-

or Close a document, etc.

== Click the Office Button @

®7




m, E?‘-ﬂgiuﬁaﬂj.,; 5

*fm*i ;1 ﬁv&-u ;i'u,f-.w

Quick Access Toolbar -

' Quick Access Toolbar is located next to the office button. It holds the
‘commands which are used frequently.

Ribbon

The Ribbon is the panel below the title bar. It presents commands organized
Into a set of tabs called Ribbon Tabs.

Ribbon Tabs

pra-

Command Button ~ Font Group  Dialogue Box Launcher




Unit -3
The Ribbon is divided into seven tabs and each tab is a collection of several
groups that show related items together.

Tab is a collection of several groups of related commands.
Groups show similar commands together.

- Dialogue Box Launcher gives access to additional commands.

. Command Buttons are used to issue commands or 1o access menus and
dialogue boxes.

1. -

The following steps are réquired to create a new document.

Click the Office Button ‘%, i B

Click New or press Ctri+N. | B o

Click Blank document. _

e e 8

“Fig. 3.3.1a New Document Dialogue Box

Click Create.
A new blank document appears on the screen.




= Unit-3

Adding, removing and re-arranging text in the document is called text editing.

- = ] i
fr . 5 Tilird® F~} &
e B

A flashing vertical line on the screen is called cursor or insertion pointer. The text we
type will appear where the insertion pointer flashes on the screen. <
As we type, the insertion pointer moves horizontally towards the right of the screen.

When we reach the end of a line, Word automatically wraps the text to the next line.
Open a blank document.
~ Type the following sentence.
I love Pakistan.

" Place cursor after the word ' love ',

“ Press _=_]| key to remove the word ‘ love " . '

~ Type the following sentence.

Fig, 3.3.2 Texr Editing




3 3.3 Se!ectmg Text

Before using any Word feature, a user must first select the required text. Selected
text appears highlighted on the screen. ;

How to select text ?

It is very easy to select text in a document.

= Open a saved document.

O the Insert mhm;ems that are designed o coordinatc with th
rwducumut."fuummcmm 5 ;

=8 Select an entire document.

Mmﬂupoimlmmehﬁnfﬂmpmaphmndmgum=@ﬂwmmﬁm
tripple-click or press Ctrl + A. '

"




3.3.4 Deletmg Text

Removing text from a document is called deleting. A user can remove unwanted
text from a document. Following are two different methods to delete text.

@ To delete a single character
Click to the right of the character and press the @ key.
@ Todeletea word or a block of text

Select the text and then press me. key.

3.3.5 Copying and Pasting Text

The Copy command creates a duplicate of the selected text, leaving the original text
unchanged. The Paste command pastes the copied text at the insertion point.

When we copy and paste text, the text appears in both original and new locations.
@ Select the text and click the cupyﬁ button or press Ctrl + C on the keyboard.

@ Move the cursor where text is to be placed and click the pasté button or
' press Ctri + V.

3.3.6 Cutting and Pasting Text

A user can move text from one position to another in a document using the Cut
and Paste commands. The Cut command deletes the selected text from its original
location, The Paste command then places this text at the insertion point.

@ Select the text and click the cut ﬂ button or press Ctri + X on the keyboard.

@ Move the cursor where text is to be placed and click the pasteﬁ button or-
press Ctrl + V. e




Cut, Copy and Paste Text (Provinces of Pakistan)
~ Make a list of four provinces of Pakistan.
Provinces of Pakistan
Sindh
Balochistan .
k hyber Pakhtunkliwa -
Punjab '
Select this list.

Click chﬂ button or press Ctrl + C and de-select the text.
Press key.

<+ Click Paste E button or press Cirl + V. !

To de-select text, click
outside the selected

% Another list of four provinces appears.

~ Cut and paste them so that most populated province is at the top.

—_—

..l_":"'l- |~ . } ... il o -

Sindh

Balochistan

Khyber Pakhunkhwa
Punjab

Provinces of Pakistan
Punjab

Sindh

Khyber Pakhiunkhwa
Balochistan

~ Now Cut and Paste them In reverse order. T, Loy antE et




Font is a set of letters, numbers and symbols of a specific design that may be displayed
or printed. Fonts make the appearance of a document beautiful and attractive. Fonts
have names such as:

Font Name Exampl‘e;
Arial Different styles of writing are called fonts.
Times New Roman Different styles of writing are called fonts.
Magneto Different styles of writing are called fonts.
Impact Different stytes of writing are called fonts.

\We can choose different fonts to suit the type of a document. For example, if we are
writing a notice to place outside a door, we may use bold fonts( e.g. Arial Black, etc).
Similarly, If we are writing a business letter, we may use formal fonts( e.g. Times New
Roman, etc). Few more examples of fonts are as follows.

STOP NOW THESE WORDS ARE HARD AND BOLD
Stop Now These words are scary
Stop HMow Jhese words are fancy

Font size means the height of letters or other characters. We can increase or
decrease the size of text in a document. Word measures the size of text in points.
There are approximately 72 points per inch.

Type your name and school's name as follows.




Wurkmg Wiﬂl Word

Madeem Nasir,
Govt. High School, Chak No. 149, Arifwala

Fig 3.3.8a A Word
= Select it,

=% On the Home Tab, in the Font group, click here to see a list of fonts.
=% A drop-down list of fonts appears.

=P Choose a new font. b

Fig 3.3.8b Changing Font '
=% Select the text.

=%  On the Home Tab, in the Font group, click here to see a list of font sizes, |




=5 A drop-down list of font sizes appears.

.-} Select the font size 48.

=% Font size of your name and school's name is changed. ’f..-.!—

Nadeem Nasir,
Govt. High School, Chak No. 149, Anfwala

Fig, 3.3.8¢c Changing Font Size

3.3.9 Font Styles

To emphasize information in the document, a user can make the text bol:l italic and
underlined. A user can easlly activate any of these formatting commands by clicking any

of the foliowing buttons.

i Bold catches your attention.

’ ltalic is stylish.

] Undsrtine ighlis e
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Early to bed and early to rise
Makes a man
Healthy, wealthy and wise.

Fig. 3.3.9a Eﬁwngfmm
i Select the first line of the poem.

" Onthe Home Tab, in the Font group, click the bold button B
to make it bold and underiine button 2] to underline it

Early to bed and early to rise You can apply all three
effects bold, italic and
Select the second line of the poem. underline to the selected

=
text.
= Click the ttalic button ] or press, - ~

= Similarty, on the third line of the poem apply the underline effect x ;

Fig 3.3.9 Chauging FMe
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Alignment Is the way in u.rl'nich"c&t is placed between the margins of a page. We can
enhance the appearance of the document by changing the position and layout of the
text on the page. Text alignment can be changed by using these E = 5| 5| buttons.

Left Align E Center ﬂ

Aligns text at the left margin. This is The text is centralized on a line. It
the default setting. Left alignment of can be used in a card, on an envelope
text is found in most documents. and in a listing,
Right Align = | Full justification |
Aligns text at the right margin. This The text is justified on both sides.
can be used for addresses. It can be seen in books, newspapers,
- magazines and reports.

Alignment of Text
Type a short poem.

Sl T

segadlt

Early to bed

And early to rise

Makes a man

Healthy, wealthy and wise

Fig. 3.3.10 Alignment of Text

Hold and press A to select all text.

On the Home Tab, in the Paragraph group,
click each Align icon ﬁ ﬁ ﬂ ﬁ one by one to see new layouts.

93
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3.3 11 Changing Case of Text

We can change the selected text to UPPERCASE, lowercase or other cases.
There are five case options available in Word 2007,

_ @ Sentence Case

First character in the sentence is in uppercase and the rest are In lowercase.

® lower case All characters are in lowercase (small letters).

© UPPERCASE _All characters are in uppercase (capital letters).

& Title case First character of each word Is capital and the rest are small.

® tOGGLE cASE  Frst character of each word Is small and the rest are capital. :
Changing Text to Upper Case

=& Type your name,

443y

&

Select your name.

On the Home Tab, in the Font group, click Change case icon.

Change case menu appears. . || semence ene.
i

Now select the UPPERCASE option. -

Your name changes to the new case style.

Fig. 3.3.11 Changing Case of Text

|
£
g

MUHAMMAD NADEEM

Now, one by one, use other four options.
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Word underlines possible spelling and grammatical errors in the document. Words
that are not in Word's dictionary are underlined with a red wavy line. Grammatical
errors are underlined with a green wavy line.

Spelling and Grammar Check

=% Type the following p

— -

.

e e b

Drawing room are the largast room in my house.
It is well decorated by my mother. It has two
sofa sets and a carpet on the floor.

. a . : Fig. 3.3.12a Spelling and
=% On the Review Tab, in the Proofing group, . G ChGE

click Spelling & Grammaricon.

wh  Spelling & Grammar dialogue box appears if
Word finds an error in the document.

=% In the beginning, Word displays the spelling errors.

= Click Change to correct error in the document.
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=% Similarly, correct all spelling errors.
=% Next, a window appears showing the grammar errors. gt

A e T e T

Fig. 3.3.12¢ Spelling and Grammar Dialogue Box, == ‘{'
=% Choose the right suggestion.

 Click Change to correct error in the document________|

= Similarty, correct all spelling and grammatical errors
until this dialogue box appears.

3.3.13 Séving a Document

After completing the work, the user can save the document for future use. To save
the document the user has to give it a name. :
Following steps are used to save a document.

=% Open a blank document.
=% Type your name, class and school's name.

. or press Ctrl+§ '
to save the
document.




=& Save in
My Documents..

=9 Type a name of
your work here.

Fig. 3.3.13a Save As Dialogue Box

=% Click Save.
This will save your document with the name My First File
in the folder of My Documents.

Kammnu Akmal
Chass: 6eh A

roivt. Istemin High Schood
Labome,

Fig, 3.3.13b Saved Docment

97




3.3 1‘4 Pnntmg a Fu" Document
A user can easily produce a hard copy (paper copy) of the document. A user
can print a single page, specific pages or the entire document.

=5 Open the document *My First File.dooX™

g o
glhm: L‘H

ml Temes Mew Roman -j_
5 -

=% Click the Office Button.
=% Point to the arrow next to Print o
H e Lena e dodument directly 1o the Jefault
or just press Ctrl + P Rl ses _Q, Presie 30d akE (AR 9 Bages Bedee
o qu
: = Z Erponin *
Before printing the = R
document, make sure. IS :
that the printer is ON o e
and it contains paper. B oo
ngﬁ.uammnmm
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Usmg Medla Piayer

3.4 Using Med:a P’&yi.?f‘

Media Player is a software which plays video and audio files. In Microsoft
Windows this software comes with the name Windows Media Player. In this
player, we can watch movies and listen to songs from CD/DVD or from already
stored video and audio files in the computer.

OpenhgllﬂndumMaNayer

=» Click Start. Wy ~
=P Point to All Programs™=® Accessories sp Ememnmem

=» Click Windows Media Player. ——

Accessorics  Enfertainment

All Programs  Sfart Button




_Menu

_Autohide Menu bar I8

‘Seek bar

 Volume slider
_Stop button | . Mute button Fast forward bution
Previous button | | Next bution

Fig. 3.4a Windows Media Player

3.4.1 Using Playback Controls

The buttons which are used to control an audio/video file are known as playback
controls. There are several playback controls in media player Some of the most
important playback controls are discussed below.

Play/Pause (& (W)

This button is used to play and pause any audio/video file. When a file is
playing, it turns into pause button and when a user pause a file it turns into
play button.

Stop @ —

Stop button is used to stop any file playing in media player. A user can play it again
by clicking on the play button. The file will start playing from the beginning.



. l—

Using Media Player TR Unit-3

Fast Forward/Rewind Cao C22d s
These buttons are used to control the speed of the file. A user can increase the file
speed by clicking the fast forward button and decrease the speed of the playing file

by clicking the rewind button.

Adjust Volume and Mute ©OFGs

The volume slider Is used to control the volume level of the file. A user can move the
slider right to increase the volume and left to decrease it. You can also tum off the

volume of the file by clicking the “Mute” button.
3.4.2 Playing a Recorded Clip From
CD/DVD

= Insert a video CD in the CD drive.

ey %9 - Fig. 3.4.1a My Computer Window
= Double click CD drive icon
in the My Computer.

e ; o

101 e .-




Fig, 3.4.1b Contents of CD
=% Double click the MPEGAV folder.

=% Double click the AVSEQO! video file.

= The video file starts playing in the Media Player.

Fig. 3.4.Ic Media Player Playing a Video



Microsoft Paint is a graphics software. It is used to draw and edit images.
Brush tool is used to draw lines with different thickness.

Rectangle tool is used to make rectangles.

Ellipse tool is used to make ellipses.

Line tool is used to draw straight lines of different colors and thickness.
Curve tool is used to draw curved lines of different colors and thickness.
Fill with color tool fills the screen or an enclosed shape with a color.
Airbrush tool creates a spray pattern.

- The color palette consists of two rows of colored boxes. To set the

foreground color, click on any colored box.
The foreground color is the color that the pencil draws with.
The background color is the color of the background.

Pencil tool is used to draw freehand. However, you cannot adjust the thickness of
the line with this tool. '
Text tool creates a text frame in which a user can choose the font, size, and style

to type.
Typing Tutor is a software which helps a user to learn and improve typing skills.

ASDFand]KL; are called home keys.

SpeEd';‘n typing is defined as the number of words typed in one minute
counting every 5 strokes (punctuation marks, spaces or letters) as one word.

The software used to produce documents is called Word Pmcessaf:

Microsoft Office Button provides fast access to files and frequently used
commands.

Quick Access Toolbar holds the commands which are frequently used.
Ribbon presents commands organized into a set of tabs.
Adding, removing and re-arranging text in the document is called text editing.

Selected text appears highlighted on the screen.

The Copy command creates a duplicate of the selected text leaving the original
text unchanged.
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The Cut command moves the selected text from its original location.

@ The Paste command pastes the copled and cut text at the insertion point.
@ Fontis a set of letters, numbers and symbols of a specific design that may be
displayed or printed.
@ Font size means the height of the letters or other characters.
@ To emphasize information in a document, a user can make the text bold,
italicized or underlined. !
@ User can change the selected text to UPPERCASE Howercase or other common
capitalizations. -
@ Word underlines possible spelling and grammatical errors in the document.
@ Media Player is a software which plays video and audio files.
@ Play/Pause is used to play and pause audio/video file. -
@ Stop button is used to stop any file playing in the media player
@ Fost forward and rewind buttons are used to control the speed of the file.
@ The Volume Slider is used to control the volume level of the file.
Exercise
Q. | Tick the right cholice.
) Paint is a software.
a) Graphics b) Typing
©) Word Processing d) Mathematical
i) A user can draw perfect circle by ellipse tool using key while dragging
the Mouse.
a) Curi ~~b) Shift
¢) Caps Lock d) Alt
iii) tool is used to write text in the drawing.
a) Shift b) Text \
©) Pencll d) Curve ‘
iv) Airbrush tool creates a pattern.
a) Spray ’ b) Line

c) Curve d) Color




tool is used to fill the screen or a closed shape.

b) Text
Alne ) Fill with color
vi) tool is used to zoom in the drawing.
a) Line b) Magnifier
¢) Brush d) Curve
vil) keys are called home keys.
AASDFand)KL; BYQWERTY
QZXCVB dFGHJKL
viii) Is defined as the number of words typed in one minute.
a) Typing tutor b) Typing skill
@ Typing timing ©) Typing speed
) are the keys settings for the left hand.
AASDF b)QWER
QZXCV dDFGH ;
x) is the most popular word processing software.
a) Word b) Excel
¢) Paint d) Notepad
i) button is located on the top left corner of Word 2007
a) Microsoft Office button b) Ribbons
¢) Microsoft Home d) Save
xii) The is thé panel at the top of the document.
a) Ribbons b) Office button
<) Tab

xiii) Delete key deletes the characters from the

a) Left
A Up

d) Quick Access Toolbar

side of the cursor,

b) Right
d) Down




Xiv) ' is a software which is used to play audio and video files.

-

a) Media player b) Typing Tutor

¢) Word d) Paint
xv) Mute button is used to the volume .

!

a) Tumn on b) Increase

¢) Tumn off d) Decrease :
Q. 2 Fill in the blanks. '

e

I Pencil tool Is used to draw

i) Airbrush tool creates a pattern.

iii) The home keys consists of. keys.

iv) is used to press Space bar

v) Word is a processing software.

vi) ' show similar commands together.

vii) Adding, removing and re-arranging text in Word document is known as

viii} is the shortcut key to bold the text

b errors are underlined by green wavy line.

x) button is used to stop any file in the Media player
Q.3 Define the followings.

I} Text Editing ii) Ribbon

iii) Toolbox . Iv) Playback Controls

v) Text Alignment



Cdmmonly Used Software

Q.4 Differentiate between the following.

1) Brush tool and Pencil tool ' : i) Delete key and Backspace key
iii) Foreground and Background color boxes iv) Pause button and Stop button
v) Cut text and Copy text :

Q.5 Give brief answers to the following questions.

1) What are the uses of Paint?

i) How can a user draw a freehand drawing in Paint?

ii) Explain the importance of home keys in typing.

iv) Write the steps to create new Word document.

v)_ Write the names of different case options in Word 2007

vi) Define the font and write the names of three famous fonts.

vii) Explain text alignment and its different types.

viii) Write down fhe steps to access Media player in the Windows?
ix) Write name of the tool used to draw curves.

%) How can we draw a circle in Paint?

Q.6 Match column A with column B and write the numbers of matching pairs
In column C.

DAS DFJKL; a) Fill the closed shape
it) Brush tool b) Spray
i) Text tool ¢) Brush strokes
iv) Line tool d) Home keys
v KL; e) Right hand keys
vi) Fill with color f) Text frame '
vil) Eraser tool g) Straight line
viii) Airbrush tool h) Erase a picture
D) Left hand keys
) Typing Speed e
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Q.7 Match column A with column B and write the numbers of matching pairs

il | | I
Il ||

* In column C,
) Word processing ‘aCri+X
ii) Media player ) Times New Roman
iil) Increase playback speed| d) Turn off volume
iv) New document e) Ctri + P
v) Font f) Fast forward
vi) Cut Text £) Windows Media Player
vii) Print hCtrl+N
ix) Font Style 1) Italic
x) Mute j) MS Word
k) Ctrl + C
DCtl+N
Q.8 Label the following diagram.
a)

- r-__ i

A T TR T [ VR, L
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Commonly Used Software

Lab Activity (Using Shape Tools)

»h Select the rectangle tool !] ;

= Draw two rectangles like this.

= Using bucket tool color them gray.

= Draw a rounded rectangle inside
the big triangle and color it white.

Lab Activity (To Draw a Tree)

= Select brown color from the color box.

=% Click brush tool ﬂ and use thick
brush to draw stem and branches.

Now select green color from the color box.

-
=P Draw leaves using brush tool.

Activity (Using Brush Toel)

/
=P Click brush tool . and draw a heart
with blue color

s Select another color and write some

O PI\V:I&TAN
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Lab Activity (Spray Tool)

=& Spray tool . can also be used for

the leaves of a tree.

z

= Click and move the spray can quickly

to make the leaves.

=% You can also change
the size of the spray. I

Lab Activity (Face)

=% Use brush tool for the face and
spray tool for hair

= Chang the hair style.

Lab Activity (Brinjal)

wi Using ellipse tool . draw an oval.

wi» Use magnifier tool to make it big.

; X

" wUsing brush 00! draw upper
: portion of a brinjal.

w Color the brinjal with airbrush tool.

n




Commonly Used Software

Lab Activity ( Changing Font Size and Color )
= Type your first name.

Arif
Double click to select it.
F—"J‘%?ﬂ
Cuckc Eopy B o Press cri+

De-select the word.

##il»

Clickpaste or Press Ctrl + V.
ArifArif

Now similarly paste your name six times. '

L2

Put twb spaces between each one.
Arif Arif Arf Arif Arif Arnf
= Now rhake each name bigger than the last ohe.
Y L]
ast A Arif Arif Arif AT
Color each name a different color.

You can do this by selecting a word
and choosing color from here
on the Home Tab and in the

Font group.

‘3

acit Anif Arif Arif Arif AI‘lf
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Commonly Used Software

Lab Activily ( Font Chart ) -.-
= Type capltal.alphabet.- '
wh Select it. K T

= Copy and paste it nine times.
ABCDEFGHIJKLMNOPQRSTUVWXYZ
ABCDEFGHIJKLMNOPQRSTUVWXYZ

ABCDEFGHIJKLMNOPQRSTUVWXYZ

llllll L R N
“

ey Ncwselwmﬂﬁatammdgheeachﬂneammmmh:
= Write the font name after each fine. s

ABCDEFGHIJKLMNOPQRSTUVWXYZ.........ccovsnnss ( Arial )

ABCOEFGHITKLAWOPGRSTIVNDYZ...................{ Chiler )

ADCDES SHIIRLNMN EL CRSTUYTEYZ.cr e ( @alligraphia )

ABCDEFGHIIKLMNOPQRSTUVWEY Zeverusweens{ Cooper Black)
ABCDEFGHIJELMNOPORSTUVWXYL. ......coverenens ( STENCIL )

b v =P HOOBE AR+ 08 FBRG..............{ Wingdings )

3.




Commonly Used Software

Lab Activity ( Editing )

=& Open a new document and save it as “Application”.
=h Type the following text.

wh  Use the Arial font.

m Perform the editing and formatting as shown.

b) Place

a

here. To = ;
The Pﬂ!'!ﬁ_PﬁF. a) Reploce with:
Gowt. Islamia High School, ety
Multan -
Sir

Respectfully, | beg to state that | am sick.
Therefore, | cannot come to school. Kindly - cjfustify this
grant me a leave for two days. | shallbe |  Paragroph
very thankful to you.
2 _ 1 d)bold
Yours obediently,
ﬂm Shahzad Khan e . e) ltalicize
Class 6th, A.
- Roll No. 15
Lab Activity ( Top Ten TV Programs )
s Make a list of ten TV programs.
3 POGO
Thunder Cats
National Geography

=P Cut and paste them so that your favorite is at the top.
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THE INTERNET AND
- WORLD WIDE WEB

The Internet is the collection of a large number of s
computers connected together all over the world. By using
Internet we can look up information on any subject or send and receive

messages through e-mail. |
In this unit, we will also discuss the World Wide Web - the fastest growing

area of the Internet made up of millions of web sites.

Learning Outcomes:
After completing this unit, students will be able to:
define Internet know the World Wide Web
know what Internet offers know web page
know the means of connecting to know web site |
the Internet know the URL '
. Telephone (dial up) modem know a web browser
DSL use of Internet Explorer
Cable modem connection know the search engines
explain the step involved in accessing Google
Internet Yahoo

M5N



4.1 Introduction to the Internet

Today billions of i_Jsers ground the world access the services of the Internet. We
can exchange messages, share information, buy and sell things and communicate
with gach other while ysing the Intgrnet.

4.1.1 internet

The Internet is the largest network of computers around the world. It connects
many smaller ngtworks together and ajlows all the computers to exchange
Information with each pther

A network is a system of interconnected computers that communicate with
one another ang share application, data and hardware &empnqents.

Fig. 4 1.1 Internet
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Introduction to the Internet

4.1.2 Intemet Services
The Internet has become so important fhat its use Is considered as the essenjial
P3u of computer use. The mgst gommgnly psed internet services 3rg shgyn

bylow

fuwm
Il‘

The World Wide Web
World Wide Web is a collection of webpagesonﬂ'le Internet which provide a

valript;r of information that can be acces;gd by people all over the world.

A user can send gnd receive glectronic messages and files to anyone in the
werld using E-mall service.

A user can buy and sell things on Internet while sitting at home.
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Introduction to the Internet

A user can chat with anyone using this service. Chat room is a location on
Internet that allows users to chat and share ideas with one another,

instant Messaging (IM)
A user can chat with his/her online friends using the service of instant:
messaging. Some IM services also provide audio and video conversation.

News

A user can read a news;}apér online. A user can access web sites of
different news channels to keep themself update.

Entertainment

A user can access unlimited range of pictures, mu;lc angd videos using Internet.
A user can alse play online ecomputer games.

Education

A user can access books and articles of any subject on the Internet, A user can
take online lectures and training on different subjects.

4.1.3 Means of Connecting to the
Internet

When a user wants to access Internet, first of all he/she
has to establish a connection of the computer to the
Internet. This connection is provided by a company
which is known as Internet Service Provider (ISP). These
ISPs offer different types of connections.

@ Telephone (dial-up) modem
#® Cable modem

@ DSL (Digital Subscriber Line)
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Introduction to the Internet

Telephone (Dial-up) Modems

Dial-up connection |s a technology that helps a user to connect to the Internet
using standard telephone lines. A user can access Internet by plugging in
telephone line in the modem. It is a slow speed and jnexpensive technology. In
this type of connection telephone line remains busy, ope cannot make calls,

Phone Line

Internet Service Provider (ISP)
Fig. 4.].3a Dial up Connection

Digital Subscriber Line (DSL) Modem Connection
DSL is a high speed Internet technology that runs over standard phone lines.
It is one of the fastest and affordable Internet connection. A DSL modem Is
connected to the computer with a network Card. In DS|. connection,
telephone line remains free to make calls.

A Computer
with a Network Card

v -

DSL Modem

Internet Service Provider (1SP)

Fig. 4.1.3b DSL Modem Connection




Introduction to the Internet

Cable modem service I a technology that helps users to cgnriect 19 the
Internet using theg cale TV wire. It provides 2 high speed conbection as
compared to the gial-up modems. It proviges an “ajlways ON" copnection. It
means whenever a computer is powered @n the connection is “ON". Cable
modem can be cqnnected to the camruter with the netwark card.

Clhhwm t' ;’

n;,u..nmwm

4.1.4 Connecting to the Internet

Wﬁmmmemmmﬂﬂjem

I. Computer
2. Modem

3. Telephone/Cable TV Line
4. ISP (Internet Service Provider)
5. Web Browser

. Computer
Computer is the mgst gssential part to access the Internet. We cannot 1cc¢s§
Internet withqut a omputer. {5 J




o
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Introduction to the Internet

A Modem is a device which is used to conhect and commynicate with other
computers. There are two types of modems:

Internal Modem External Modem

Piaced inside sytem unit, Placeduutslqamtﬂnmrpnrsw
used for dlal-up connection for DSL and Cablg mogdem connection

3. Telephone/Cable TV Line

A telgphone line Is required for Digl-up
and PSL connections. -

A Cgble TV line is required for Cable
modgem connection.

4. Internet Service Provider (ISP)

A cqmpany which provides an Internet connection is known as Internet Service
Pm\?pqr (USP). Some of the leading ISPs in Pakistan are:

® P3kistan Telecommunication Limited
® Vyateen Telecom

® World Call Telecom

® Wy-tribe

5. Web Browser - .
A web browser is a software which is used to access and view different
websgites. Some popular web browsers are:

® Micrpsoft Internet Explorer !

® Mpzilla Firefox 4
® Gpogle Chrome

L G_P_E.‘Fd




The World Wide Web

4.2 World Wide Web (The Web)

The World Wide Web is the most popular service provided by the Interngt. It
s also known as “The Web". The Web is the collection of web pages on the
Ipternet. It contains a variety of information that can be accessed by the people

qll over the world.

4.2.1 Web Page

Web page is a document on the World Wide Web. It can contain text,
g
Fraphi::s, audio, videos and links to other pages.

Fig. 4.2.1 Web Page




The Warl‘d Wide Web

4.2.2 Website

A Website is a collection of related Web pages. Each website contains a numbler
of documents and files.

The very first page of the Website is known as Home Page. It serves as &n
introduction of the entire website, A user can access any website in the world
by writing its address in the address bar of the Web Browser. He/she can move
from one page to another page of the website.

This Is the home page of the Pakistan Air Force website.

4.2.3 URL (Uniform Resource Locator)

URL (Uniform Resource Locator) is an address of a web page on the

". Every web page has a unique address. A web page can only be
accessed if we knuw the URL of that page. For example, Google is one of the
most popular websites and its URL is http://www.google.com.
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Fig. 4.2.3 Google Home Page

4.2.4 Web Browser

Web browser is a software that Is used to access the World Wide Web.
We can access and view different web pages or websites using a web browser. '

It is a user-friendly software, We can type URL of any website on its address bar,
and the browser will show that particular website.

Some of the most popular
browsers are Microsoft internet

Explorer, Mozilla Firefox, Google
Chrome, Opera and Safari.
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The World Wide Wr*h

4.2.5 internet Explorer

In Windows, the software which serves as a web browser is known as Internet
Explorer. It has different menus, buttons and icons to hel;i a user to access
different websites and webpages.

igar ) L Hndtyia
Bea

I'I'Hl.-l.“h i

Address Bar
You can type the URL of the desired web site here.

.. Refresh Button . "
Awenpageisre-madeawchmngmnsuunm

Stop
- You can stop the browsing of a web page by clicking this button.

, Back and Forward Buttons '
These buttons are used to go back and forth among pages of a website or multipie

ﬁbsm&s .These buttons enable only when user visits more than one page.
nus

You can use different menu options by using these menus.

New Tab Button
A new tab window opens by clicking this button.
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The World Wide Web

4.2.6 Accessing Different Web Pages
Using Internet Explorer

=) Open Internet Explorer

= Type the URL

www.google.com

in the address bar.
=% Press Enter kel

._Fﬁ' -&?LH mwm md
-}Thembpagenfmbgleappearﬁ : e R
?___ S
P e
m-.ﬂ
e L e
Fig. 4'.2 b Imternet .Exp.i'w}
= Now, one by one, type the following URLs in address bar of Internet -.
Explorer.

1) wwwyahoo.com
2) www.bing.com

3) www.typingtutorcom
4) wwwifunbrain.com
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The World Wide Web

4.2.7 Search Engines

Search Engine is a program that is used to find web pages and websites on the
Internet. When we type a word or a phrase, the search engine will show a list
of websites with related information.

Some of the most popular search engines are listed below.

MSN (www.msn.com)

Yahoo (wwwi.yahoo.com)

Google (www.google.com)

Altavista  (wwwaltavista.com)

Ask (www.ask.com)

Ere . E L - oo — et

-"-I'-'-—"'.-- L - :-:l:-hln._‘ - ¥

— = B e - e - e R
¥

B - = .

I“‘l’_ﬁ v | 1:.
. o i A ———
— e T
: E&.

- :- '._'ﬁ-;'- - =

e ol e . Lot - A — - : T
E;'-:"ﬁ.‘;'_-'ﬁ-- o . m— s |
s —m

==, ol — —— — - ——

. A e P SN
— S — T — W"—Hrmeum-i——.
' Fig. 4.2.7a Different Search Engines

127




.! il J.;;:.)ﬁ

The Wnrld Wide Web

= Open Internet Explorer.

=% The home page of the browser opens.

By default MSN is set as home page of Internet Explorer

w If MSN is not your home page, type the URL

WWwW.msn.com
in the address bar
and press Enter key.

= The web page of
MSN appears.

Fig. 4.2.7b Internet Explorer (MSN ha
= Type “Pakistan Cricket Team” in the search bar
and Click search button.

=& List of related web pages
or web sites appears.

I Bl rl--t--pnl kel anm

: _umu
-“ vy -
Pl iyl -
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The World Wide Web

Using Yahoo Search Engine

mp Open Internet Explorer.

mP The home page of the browser opens.
By default MSN is set as home page of Internet Explorer

mp Type the URL mmyaimcam in the address bar
and press Enter key.

=) The web page of
Yahoo appears.

P o R i o i P ]

[ ot
s NN RE e
ﬁﬂ?ﬂfmmﬁmwm

=® Type “Pakistan Cricket Team” in the search bar
and Click search button. ¢

- List of related web pages
or web sites appears.

i e L
m“‘_ e, 8 o B e B ndnd LT s

W - -mnqw.
i ey e waas -
e e

v e T b

s-ﬂilﬂ-ﬂlﬂ'ﬁ—m--——-l-

EiE WS o iid i o ——
|

W STt E:... = —1:i - -—+

4 Fig. 4.2.7¢ List of Related Web Pages
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The World w.l‘di;’ Web

= Open Internet Explorer,

= The home page of the browser opens.
By default MSN is set as home page of Internet Explorer.

= Type the URL www.google.com in the address bar
and press Enter key

=H The web page of
Google appears.

N oo ]
F@.ﬂlﬂ'fm#m

=P Type “Pakistan Cricket Team” in the search bar e sodicit o
and Click search button,

e e R

= List of related web pages
or web sites appears.
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© The Internet is the largest network of computers around the world.

® A company which provides an Internet connection is called ISP

© Dial-up connection is a technology that helps a user to connect to the
Internet using standard telephone lines.

© DSLis a high speed digital, always-ON Internet techﬂolag)r that runs over
standard phone lines.

© Cable modem service is a technology that helps users to connect to the
internet using their cable TV wire.

® A modem is a device which is used to connect and communicate with other
computers.

© A web browser is a software that is used to access and view different
websites. ;

© The World Wide Web is the collection of web pages and websites on the
Internet.

# A Web page is a document on the World Wide Web. It can contain text,
graphics, audio, videos and links to other pages.

© A Website is a collection of related web pages. Each website contains
a number of documents and files.

© URL (Uniform Resource Locator) is the address of a web page on the
Internet.

® In Microsoft Windows, the software which serves as a web browser is
known as Microsoft Internet Explorer.

© A Search Engine is a program that Is used to find web pages and websites.

Q.1 Tick the right choice,

) The largest network of computers around the world is known as

a) Internet - b} Network
¢) Intranet d) Grotp
ii) IM stands for
a) Instant Making b) internet Messaging

c) Instant Messaging d) Instant Messages
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The internet and World Wide Web
fii) ISP stands for.
a) Intermal Server Provider b} Intemet Service Provider
) Internet Supply Package d) Internet System Provider
iv) DSL stands for
a) Digital Subscriber: Line " _b) Digital Super Line :
¢} Data Subscriber Line - d) Digital Subscriber Lane
v) There are types of modems.
\
al Two ) Three
o) Four d) Five
i
vi) Which of the following is an Internet Service Provider?
a) PLIC b) PLCT 4
A PCIL d) PTCL s

vil) The software that is used to access and view web pages is called

a) ‘Web Server k) Web Browser
c) Web BExplorer ; o) Web linker
vill) WWW stands for.
i
a) World Wide West b)) World Was Web
) World Wide Work ) Wald Wide Web

ix) Collection of different web pages and sites on the internet is also called

a) Wek b) The Web
c) Web Link d} The Wax

x) A single document on the world wide web is known as

a) Web page b)) Website
) Web link d) Web cam
xi) A is a collection of related web pages.
a) Web site ) Web Page
) Web browser d) Web cam
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The Internet and World Wide Web

xiil) The web address of the web page is known as

) Ll b) LIRS

=3 Wl d) ORI
xiv). is the home page of the Internet Explorer.
&) ASH B) M
¢) MNS d) MM
xv) is a program that is used to find web pages and websites.
a) Find and Seanch b) Explore Engine
c) Search Browser d) Search Engine
Q.2 Fill in the blanks,
DA Is a systemn of interconnected computers.

ii) A user can send to and receive a message from any one in the world through
service.

iil) We can buy or sell things éltting at our home using Internet is known as
shopping.

iv) Internal Modem is placed inside the

v) The company that provides Internet connection is known as

vi) A DSL modem connection uses _ lines,

vii) In Windows, the software that serves as a web browser is called

iil) We can access any website by writing its URL in the of the web
browser.

ix) The very first page of the website is called : page.

x) is the most popular search engine in the world.

Q.3 Define the following.

D) Internet i) World Wide Web fii) DSL

iv) Web Browser v) Web site vi) URL
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Q.4 Give brief answers to the following questions.
i) List five uses of the Internet.

ii) Write steps to connecting to the internet.

iii) Define Modem and its types.

iv) Write names of some popular web browsers.

v) What are the major differences between Dial-up and DSL connections?

vi) How can we access websites in Microsoft Windows?

vii) Describe Cable Modem Internet connection.

viil) Describe the function of Refresh, Stop, Next, Back and Stop buttons in Internet
Explorer

iX) How can we search a web page using Search Engine?

X) Write names and URLs of some popular search engines.

Q.5 Differentiate between the following.

i) Internet and World Wide Web

ii) Chatting and Instant Messaging

i) Web page and Website

iv) Telephone Modems and Cable Modems

v) Web Browser and Search Engine

Q.6 Label the following diagram.




y =

= .'- & = il i _i&“"’é‘
Unit - 4

Explain the Internet connection with the help of the above diagram,

Q.8 Match column A with column B and write the numbers of matching
pairs in column C, '

) URL a) Related web pages

i) Web Browser b) Largest network
fii) Website ¢) Digital Subscriber Line
iv) Search Engine d) Cable TV wire
v) Internet Service e) E-mail
vi) DSL f) Yahoo
vil) Dial-up Connection | g Internal Modem
Vi) www h) PTCL
ix) Internet i) Mozilla Firefox
x) ISP /) World Wide Web
k) Universal Resource Locator
D Data Subscriber Line
135 -




Answers

Unit 1 Introduction to Computers

Q.1Tick the right choice.
i (a) Data

iv. () Microsaft Windows

vil. (@) System unit

x (d} Printer

(k) Output

Q.2 Fil in the blanks.

Il Instructions

. Single
vil. Floppy

% Processing
Q.6 Match Columns.

1l (b) Information

v (c) QOWERTY

viil.{c) Digital Camera

xi. (b) Central Processing Unit
v, (d) Printer

fi. Facts and Figures
V. Input
vill. Versatile

If da Wb Wi vk Wh vic Vil ixe xd

Usnit 2 Introduction to Windows

Q.1 Tick the right cholce.

L. (a) Microsoft Windows
iv. (d} Bottom

wil. (d) My Computer

x (2} Status

xiil. (@) Copy
Q.2 Fll in the blanks.

L lcons
i Restore
vii. Taskbar

x. Folders

Q.6 Match Cotumns.
i, iie iitf, Wl wvc,

ii. (c) Desktop

v. (©) Recycle Bin
viil. (b) Window
xi. () File

iv. (b) Shift

li. Internet Explorer
. 5eroll
vill. Three

via, Mg
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viitd, Ixb, xh

iil. (b) Physical

vi. (b} Input

b (a) Microphone
0. (b} Permanent
v (c) Four

lii. Software
vi. System mainboard

b Output

lii. {c) Start Menu
vi.(c) Notification Area
. () Title

xii. (a) Envelopes

. (c) Drive

iil. Menu
vi. Mmdmi;e
k. Extension




Unit 3 Commonly Used Software
Q.1 Tick the right cholce.

i (a) Graphics if. (b) Shift
iv. () Spray x v. (d) Fill with color
vil.(a) ASDF and JKL; wil, (d) Typing Speed
x (a) MS'Word i, (a) Microsoft Office Button
xiil.(b) Right . dv. (2) Media Player
(2.2 All In the blanks,
L. Freehand fl. Spray
iv. Thumb v, Word
vil. Text editing Vill, Ctri+B-
x. Stop
Q.6 Match the columns.
T fil £ Vg ve,  vig vii b,
Q.7 Match the columns.
| e il £ W h, vic,  viia,  viig,

iil. (b Text

vi, (b) Magnifier
ix. (a) ASDF

wiL. (a) Ribbons
svic) Turm OF

ii. ASDF and JKL;

vi. Groups
ix. Grammatical

i, xd

Unit 4 The internet and World Wide Web

Q.1 Pick the right cholce.

. (@) Interpet i, (¢) Instant Messaging
iv. (a) Digital Subscriber Line v. (@) Two

Vil (b) Web Browser viil.(d) World Wide Web
. (2) Web Page i, (a) Website
“weiii, (a) URL ®iv, (o) MSH

Q.2 FAll in the blanks.

.. Network ii. E-mail

Iv. System Unit V. ISP

vii . Internet Explorer wiil. Address bar

% Google

Q.8 Match the columns.

H A T (Y24 ve, vic, vii g,
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iil.(b) Internet Service Provider
wi.(d) PTCL

i (b) The Web

xii. (b) Cable TV

wv.(d) Search Englne

iil. Online
Wi, Telephone
ix. Home

vilil, kb, xh




Advantages of using computers
are speed, accuracy, rellability;
storage and versatility

Airbrush tool creates a spray
pattern.
Background color is the color of
the background.

Brush tool 5 used to make
different types of brush strokes.

Cable modem service Is a
technology that helps users to
connect to the intemet using
Cabie TVwire,

CD/DVD is a portable, inexpensive
and comparatively less reliable
storage device.

Click: Quickly pressing and

releasing the mouse button once
Is called cilck.

Close button Is used to close an
openwindow,

Color paiette consists of two
rows of colored bowes.

Communication devices are
used to communicate and
connect a computer with
other computers.

Computer is an electronlc
machine which processes raw
data (input) Into meaningful
Information (output), and’ also
stores output for [ater use.
Copy command creates a
duplicate of the selected tesxt,
leaving the original text
unchanged.

‘Curve tool Is used to draw curved
iines of different colors and
thickness.

Glossary

Cut command deletes the
selected text from Its original
location,

Data: Collection of facts and
figures (unprocessed Items) are
known as data.

Desktop: The main screen of the
Microsoft Windows s known as
desktop.

Dial up connection is a
technology that heips a user to
connect to the intemet using
standard telephone lines.

Digital camera allows a user to
take pictures and store them Into

the computer Instead of a
traditional film.

Double click: Quickly pressing
and releasing the left mouse
button twice s called double click.
Dragging: To press and continue
to hold the left mouse button as
you move the mouse is called
dragging.

Drive: A storage area in any
storage device is known as drive.
Drop: After dragging, releasing the
left mouse button to move an
objectis called Drop.

D5Lis a high speed, digital, always-
on Internet technology that runs
over standard phone lines.

DVD stands for digital versatile
disc, it ks a storage device.

Ellipse enables a user to make
eflipses,

Fast forwaord and rewind buttons

are used to control the speed of
the audio/video file.
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File is a collection of data that is
stored ona computer

Foppy disk is a portable and
inexpensive storage device,
Folders are like envelops or
drawers In which a user can place
files and folders.

Fonts: The set of letters, numbers
or symbols of a specific design
which can be displayed or printed.
Foreground color is the color that
the pencil draws with.

Hard disk is a permanent storage
device of the computer It is an

inexpensive, refiable and durable
storage device. It Is foed Inside the
System unit

Hardware refers to all physical
parts of a computer that a user can
see and touch

Home keys:ASDFand|KL; are
called home keys.

Home Page: The very first page of
the VWeb site s known as Home
Page.

Icons are small images that
represent different types of
programs and files.
Information: Data after
processing is called information.
Input devices: Devices that are
used to enter data Into a
computer are called Input
devices,

Input Operation: The operation in
which a computer accepts data
and instructions for processing
from input devices is known as
input operation.




Internet is the largest network of
computers around the world,

ISP- A company which provides an
Internet connection is called ISP

Keyboard is most commaonly used
Input device, It allows user to type
words, numbers or symbaols into a
computer.

Line tool is used to draw straight
lines of different colors and
thickness.

Maximize button is used to
enlarge awindow to full screen

Media Player is a software which
plays audio and video files,

Memory Is the electronic holding
place. it stores instructions and
data that the computer’s
PrOCEsSOr Can access.

Menu bar of a window contains
different menus such as Flie, Edit,
View, Favorites. Tools and Halp.
Microphone is an input device. It
Is used to record voice In the
computer

Microsoft Office Button provides
fast access to files and frequentty
used commands.

Microsoft internet Explorer:  In
Windows, the software which
serves as a web browser Is known
as Microsoft Internet Explorer.
Microsoft Paint Is a graphics
software. It is used to draw and edit
images.

Microsoft windows [s the
software which provides a
platform to work on a
computer

Minimize button reduces a
window to a button on the task
bar

Modem is a device which Is used
to connect and communicate with
other computers,

Monitor Is an output device, It
displays information on the
SCIEen,

Matherboard is the largest circuit

“board in the computer  All the

computer components are
plugged or connected with it.
Mouse is an input device that
enables a user select commands
quickly and perform tasks.

My Computer icon gives access
to all disk drives and other
hardware connected to the
computer

My Documents folder Is used to
save documents such as letters,
reports, plctures and media files.
Notification Area: The area at the
bottom right on the screen s
known as notification orea.

Output devices: Devices that
show output are called output
devices.

Output opergtion: In this
operation, the computer uses
output devices to produce the
results of the processing
(information ).

Pencil tool ks used to draw
freehand drawing. However, the
thickness of the line cannot be
adjusted with this tool.

Printeris an output device. It gives
uutputunﬂ.‘le paper.

Processing operation: The
operation In which a computer
performs some action on the data
according to the instructions is
known as processing operation,
Processor Is the brain of the
computer It s made of the sllicon
chips fieed on the motherboard. It
converts data into information. It is
also known as CPU.

Quick Access Toolbar holds the
commands which are frequently
used,

QWERTY row: the row above the
home row s called QWERTY row.
Rectangle tool is used to make
rectangles.

Recycle Bin is the place where
Windows stores deleted files.
Ribbon presenfs commands
organized into a set of tabs.
Seanner s used to scan text and
Images Intca computer

Scroll bar Is used to view all
contents of a window vertically
and horizontally

Search Engine s a program that is
used to find web pages and
websites.

Software is the set of instructions
ghven to the computer to perform
aspecific task.

Speakers are output devices. They
aliow a user to hear sounds from
the computer

Start button displays a list of items
called Start Menu.

Status bar gives Information
about the window and Its’
contents.




Stop button Is used to stop any
file playing in media player,
Storage devices hold data,
instructions and information
permanentiy.

Storage operation: In this step,
the computer stores the output
permanently on different storage
devices such as Hard Disk, Floppy
disk, CD/OVD and LISB Flash drive.

“System unit is a box where
processing takes place. [t consists
of maln circwe board, processor,
power supply and storage devices.
Taskbar is placed at the bottom of
the =croen In the Microsoft
Windows. It includes Start button,
Quick launch toolbar, Task bar
buttons and Notification area.

Text case: A user can change the
selected text to UPPERCASE,
lowercase or other common
capitalizations.

Text editing: Adding, removing
and re-arranging text in the
document is called text editing.
Text tool creates a text frame In
which a user can choose the font,
sizeand style to type.

Text Style: To emphasize
information in the document, a
user can make the text bold,
italicized or underfined.

Title bar: Horizontal bar at the top
of awindow is known as Title bar;
Toolbar contains different
command buttons with their icons
50 & user can easily access these
commands. :
Typing Tutor ks a software that
helps a user to leam and improve
typing skills.

USB Flash memery [s a storage
device, It is a poriable, &xpensive,

reliable and durable storage.

device.
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URL (Uniform Resource
Locator) &5 the address of a web
pageonthe Internet.

Volume slider is used to control
volume level of the audioivideo
file,

Web browser is a software which
[s used toaccess and view different
websites.

Web page is a document on the
‘World Wide Web. It can contain
text, graphics, audio, videos and
links to other pages.

Window 15 a rectangular area on
the computer in which
applications or documents are
viewed.

Website is a collection of related
Web pages. Each website contains
anumberof documents and files.
Worid Wide Web is the

colflection of web pages on the
[nternet.
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Accuracy 4

Address Bar 125
Airbrush Tool 62, 67
Alfa Vista 127

Alt Key 8

Arrow Keys 8

Ask Jeeves 127

Auto Hide Menu Bar 99

Background Colors 62

Backspace Key 8
Bold 9|

Brush Tool 62, 63, 66
Buttons 8

i

Cable Modems (I8, 19
Caps Lock Key 8

CD (compact disc) 15
Center Align 93

Chatting 118

Click 9

Close Button 39, 40, 62, 82
Color Palette &2
Command Buttons 39, 40
Communication Devices 18
Computer |, 2

Copy and Paste 87, 88

CPU 12

CRT Monitors 16

Ctri Key 8

Curve Tool 62, 63

Cursor Control Keys 7

Cut and Paste 87

Data 3
Delete Key 8
Deleting Text 87

index

Desktop 32 -
Desictop Icons 34

Dialogue Box Launcher 84
Dial-up Modems 118, 119
Digital Camera 10

Digital Subscriber Line 11§, 119
Dot Matrix Printer (7

Double Click 9

Dragging 9

Drawing Tools 62

Drive 43

DVD (Digital Videa Disc) 15

Education 18
Blipse Tool 62, 67
E-mall 117

« End Key 7B
Erter Key 7. 8
Ertertainment 118
Eraser Tool 62
Escape Key 8
External Hard disks 15
External Modem I8, 121

Fast Forward Button 99, 10
File 41

Fill with Color Tool 62, 66
Floppy Disk 14

Folder 41, 42

Fonts 89

Font Size 89

Font Styles 91

Foreground colors 62

Full Justification 93
Function Keys 7

Google 127, 130
Groups B4
Group Name B2

Hard Disk 14,

Hardware 5,7

Help 82

Home Key 8

Home Keys ™

Harizontal Scroll Bar 39, 40, 61, B2

Infermation 3

Inkjet Printer 17

Input Devicesé

Input Operation 14, 20
Insertion Pointer 92

Instant Messaging (M) 118
[ntermal Modem |8, 121
Internet 115, &

internet Explorer 34, 36, 125

Keyboard 2, 5, 6, 7

Laser Printer 17
LCD (Liquid Crystal Display) 16
Left Align 93

Left Hand Keys 74

Letter keys B

Line Tool 62, 63
Lower Case 94

Magnifier Tool 64

Maximize Button 39, 40, 61, B2
Media Player 99

Memory 7

Memory Chips (2

Menu 119

Menu Bar 39, 40, &l

Microphone il
Microsoft Paint 5, 60




Microsoft Office Button 82
Microsoft Word 8, 8l
Microsoft Windows 29, 30, 37
Microsoft Windows XP 5
Minimize Button 39, 40, 61, 81 |
Modems 18, 121
Monitor 2, 5, [7
Motherboard i, 12
Mouse 2,5, 8

MSN 127, 128

MS Word User Interface 82 |
Mute Button 100, 101 |

My Computer 34, 35 |
My Documents 34

News |4

MNew Tab Button [25
Next Button 1010 125
Motification Area 33
Motebook 2
Mumber Keys 7
MNumeric Keypad 7

Online Shopping 117
Output Devices 23

Qutput Operation 26, 27

Palmtop 2 [
Pencil Tool 62, 65 '
PDA 2

Personal Computer 2
Platter 14

Plasma Monitor 16
Play/Pause Button 100
Previous Button 100

Printer 5, 17

Processing 3

Processing Operation 17, 20
Processor 12, 13
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Quick Access Toolbar 82 1
Quick Launch Toolbar 33 |

| QWERTY 6, 76

RAM 13
Read/Write Head 14
Rectangle Tool 62, 87
Recycle Bin 35, 36
Refresh Button 125
Rewind Button 100, 10}
Ribbon 82
Ribbon Tab 82

Right Align 93

Scanner 5, 10

Scroll Bar 39, 40, 61, 82
Search Engine 127
Seek Bar 100

Select tool 62
Sentence Case 94
shift Keys 8

Smart Phone 2
Software 5, &

Space Bar 7
Speakers 2, 5, 17
Speed 4

Spell Check and Grammar 95
Spindie M4

Start Button 32

Start Menu 32, 33
Status Bar 39, 40, 61, 82
Stop Button 100, 125
Storage 4

Storage Devices |4, 20
Storage Operation 19, 20
Super Computer 2
System Unit 2, I

Tab 125

Tab Key 8

Upper Case 94
USB Flash Memory 16

VDU (Visual Display Output) 16
Verstality 4

Vertical Scroll Bar 39, 40, 61, 82
Views 96

Volatlle Memory 12

Violurne Slider 100, 101

Web Browser 121, 124
Web Page 123

Website 123

Wheel B

Window 39
Windows Media Player 100
World Wide Web 1B, 122

I

Yahoo 127, 129

Zoom Slider 82




s

Clip your nails on time so that dust does not get stuck in them.
Also, wash your hands and feet regularly.
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